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About this guide

Who should read this guide

Job roles

This user guide is for people with the following job roles:

 

What this guide covers 

This guide describes how to:

• Install the VWorks software

• Migrate protocols from previous versions of the VWorks software

• Define labware

• Specify pipette speed and accuracy

• Track and manage labware using a database inventory system

• Manage user accounts

• Implement ActiveX

This guide does not provide instructions for writing protocols, running 
protocols, troubleshooting protocols, or operating devices using the VWorks 
software. For information about these topics, see the VWorks Automation 
Control User Guide, relevant Agilent Technologies device user guide or third-
party user documentation.

Software version

This guide documents VWorks software installer 10 and later.

Job role Responsibilities

Integrator Someone who writes software and configures hardware 
controlled by VWorks software.

Lab manager, 
administrator, or 
technician

Someone who is responsible for:

• Developing the applications that are run using 
VWorks software

• Developing training materials and standard 
operating procedures for operators

Operator Someone who performs the daily production work 
using VWorks software and solves routine problems.

Your organization may choose to create its own 
procedures for operators including the procedures in 
this guide.
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Related guides

The VWorks Automation Control Setup Guide should be used in conjunction 
with:

• VWorks Automation Control User Guide

• Agilent Technologies device user guides

• Third- party device user documents

Related information

For information about... See...

Accessing user guides for 
Automation Solutions products

“Accessing Automation Solutions 
user guides” on page viii

VWorks software licenses “About upgrading a VWorks 
software license” on page 2
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Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation. 

Accessing safety information

Safety information for the Agilent Technologies devices appears in the 
corresponding device user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/lifesciences/automation
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Related information

For information about... See...

Who should read this guide 
and what this guide covers

“About this guide” on page vi

VWorks software licenses “About upgrading a VWorks 
software license” on page 2

Contacting Agilent 
Technologies

“Reporting problems” on page 114
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Installing and setting up the VWorks 
software 

This chapter contains the following topics:

• “About upgrading a VWorks software license” on page 2

• “Installing the VWorks software” on page 3

• “Uninstalling the VWorks software” on page 6

• “Migrating files created in VWorks3, VWorks4, or BenchWorks” 
on page 7
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About upgrading a VWorks software license

About this topic

If you have already purchased a license for the latest version of the VWorks 
Automation Control software, you can obtain license upgrades. For example, if 
you have an instrument license, you can upgrade to a system license. This 
topic describes the available license packages for the VWorks software. To 
upgrade your license, contact Automation Solutions Customer Service. After 
acquiring a license upgrade, see “Installing the VWorks software” on page 3 for 
details on activating the new licence.

If you have a previous version of the VWorks software, uninstall it before 
installing the latest version of the VWorks software. See “Uninstalling the 
VWorks software” on page 6.

Available license packages

The following license packages are available for the VWorks software. 

This package... Is used for...

Simulation license Running the VWorks software in simulation mode. 
This license is useful for testing protocols on 
computers that are not controlling any devices.

Instrument license Controlling a Bravo Platform or Vertical Pipetting 
Station in a standalone mode. 

BenchTop license Controlling a benchtop workstation, such as the 
BenchCel Workstation, with up to 10 integrated 
devices. 

System license Controlling an automated system, such as the BioCel 
System, with no limit on the number of integrated 
devices.

VWorks Application 
Programming 
Interface license

Controlling the VWorks software using an external 
system.

VWorks Hooks 
Interface license

Integrating with LIMS, sample, and workflow 
management systems by providing a callback 
interface to hook into key VWorks software events.

VWorks Device Driver 
Interface license

Writing device drivers using a COM interface.

VWorks Software 
Developer Kit license

Interfacing with the VWorks software using the 
VWorks Application Programming Interface license, 
VWorks Hooks Interface license, and VWorks Device 
Driver Interface license.

VWorks Watcher 
license

Monitoring a folder for new files, and then running a 
predefined JavaScript function whenever a new file 
appears in the folder.
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Note: The device drivers that you receive are based on the type of license that 
you purchase.

Related information

Installing the VWorks software

Before you begin

If you have a previous version of the VWorks software, uninstall it before 
installing the new version. See “Uninstalling the VWorks software” on page 6.

If you are upgrading the license for a current version of the software, for 
example, from an instrument license to a system license, you do not have to 
reinstall the software. However, you must activate the upgraded license. See 
“Activating the software license” on page 4.

Computer requirements

If your organization uses a computer other than one configured by Agilent 
Technologies, make sure the computer meets the following minimum 
requirements:

• Computer system

– Microsoft Windows XP with Service Pack 3 or  
Microsoft Windows Vista with Service Pack 1

– 2 GHz or faster 32- bit (x86) processor, multicore preferred

– 2 GB system memory

– 40 GB hard drive capacity with 10 GB free space

– 1280 x 1024 pixel screen resolution

For information about... See...

Installing the VWorks software and 
activating a license

“Installing the VWorks software” on 
page 3

Uninstalling the VWorks software “Uninstalling the VWorks software” on 
page 6

Migrating a protocol created with 
a previous version of the VWorks 
software

“Migrating files created in VWorks3, 
VWorks4, or BenchWorks” on page 7

CAUTION If you have been using the BenchWorks, VWorks3, or VWorks4 software to 
control your devices, contact Automation Solutions Customer Service for assistance. Do not 
attempt to migrate files until you have received their guidance. Depending on your system 
configuration, additional firmware upgrades may be required to prevent damage to your 
devices.
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– Microsoft Internet Explorer 6.0 or Mozilla Firefox 1.0 with JavaScript 
enabled (required for using the context- sensitive help and knowledge 
base)

– A PDF viewer, such as Adobe Reader (required for opening the user 
guide PDF files)

• Communications interface using one of the following:

– Dedicated 10BaseT or faster Ethernet card (two network cards if 
connecting to your local area network)

– RS- 232 DB9 serial port, if you are controlling a device via a serial 
connection

To facilitate the setup process, a software installation CD is supplied. You can 
use the CD to install the necessary software and setup configurations.
 

Installing the software

To install the software:

1 Insert the VWorks software CD into the computer CD- ROM drive. The 
software installer should start automatically. 

If installer does not start, navigate to the CD- ROM drive, and then double-
click VWorks_buildx.x.x.exe.

2 Follow the instructions that appear on the screen.

3 On the last page of the installation wizard, do one of the following:

• If this is a new installation, select Launch VWorks Activation Program to 
obtain a license. Click Finish and proceed to step 4.

• If you already have a current license, clear the Launch VWorks Activation 
Program check box. Click Finish to complete the installation process. 

4 Follow the instructions in the VWorks Software Activation dialog box to 
obtain a license file for the VWorks software.

Activating the software license

To activate the software license:

1 After you obtain the license file (VWorks.vln), place the file in the folder 
that contains the VWorks software. For example, if you installed the 
software in the C:\Program Files\Agilent Technologies\VWorks folder, place 
the VWorks.vln file in that folder.

Note: If you have a simulation license and you want to use the VWorks 
inventory management feature, see “Workflow for setting up a MySQL 
database” on page 140.

2 Start the VWorks software.

CAUTION If the BenchWorks, VWorks3, or VWorks4 software was installed on the 
computer previously, do not attempt to migrate files until you have received guidance from 
Automation Solutions Customer Service. Depending on your system configuration, additional 
firmware upgrades may be required to prevent damage to your devices.
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Related information

For information about... See...

Upgrading software license “About upgrading a VWorks software 
license” on page 2

Uninstalling VWorks software “Uninstalling the VWorks software” on 
page 6

Migrating protocols created with 
BenchWorks, VWorks3, or VWorks4

“Migrating files created in VWorks3, 
VWorks4, or BenchWorks” on page 7

Reporting a problem with the 
software

“Reporting problems” on page 114
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Uninstalling the VWorks software

About this topic

If you have a previous version of the VWorks software, you must first uninstall 
it before installing the new software. This topic explains how to uninstall the 
previous version.

Uninstalling the software

To uninstall the VWorks software:

1 On the Windows desktop, click Start > Control Panel. The Control Panel 
window appears. 

2 Double- click Add/Remove Programs. The Add or Remove Programs window 
appears.

3 Select the VWorks software you want to uninstall, and then click Change/
Remove. The removal process might take a few minutes.

When the removal process is finished, the following folders and files may 
remain depending on the version of the VWorks software:

...\VWorks folder:

• Users folder

• VWorks.vln file

...\VWorks Workspace folder:

• Barcode Input Files folder

• Protocol Files folder

• Device Files folder

• RunSet Files folder

• Scripts folder

• VWorks folder

Typically, uninstalling the VWorks software without removing the registry files 
is sufficient. However, you can remove the Automation Solutions files from the 
registry if you do not intend to run the VWorks software on the computer 
again, or if you want a completely fresh start with VWorks software. For 
assistance, contact Automation Solutions Technical Support.

Related information

For information about... See...

Converting protocols created with 
previous versions of the VWorks 
software

“Migrating files created in VWorks3, 
VWorks4, or BenchWorks” on page 7

Reporting a problem “Reporting problems” on page 114
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Migrating files created in VWorks3, VWorks4, or BenchWorks

About this topic

Before you can use the new VWorks software to run the protocols that you 
created using the BenchWorks, VWorks3, or VWorks4 software, the protocols 
and associated files must be updated for compatibility. This topic describes 
some of the file compatibility issues and procedures for file migration.

Although the new software includes a file migration feature, numerous post-
migration adjustments may be required. Agilent Technologies strongly 
recommends that you contact Automation Solutions Customer Service before 
attempting a file migration procedure.

IMPORTANT After the protocols are migrated, you can modify the protocols 
to take advantage of new VWorks features, such as task looping, time 
constraints, and task groups. 

Before attempting file migration

• Contact Automation Solutions Customer Service for guidance.

• Verify whether any firmware upgrades are required.

• Make a backup copy of the files and Windows registry entries to be 
migrated, including:

– Profiles

– Devices

– Protocols

– Runsets

– Labware

– Liquid classes

– JavaScript

Preparing for file migration

This section provides a partial list of some file migration limitations and post-
migration adjustment requirements. Contact Automation Solutions Customer 
Service for guidance on issues that impact your configuration and how to take 
advantage of the latest enhancements in the new software.

CAUTION Do not attempt to migrate files until you have contacted Automation Solutions 
Customer Service for guidance. Careful planning and preparation is required to optimize the 
migration process. Depending on your system configuration, additional firmware upgrades 
may be required to prevent damage to your devices. Make sure you are aware of any 
limitations or post-migration adjustment requirements. 
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Potential migration issues

Devices name changes
During file migration, the software changes the device names in the migrated 
files. 

Issue Description

User account 
passwords

During file migration, all user account passwords are reset 
to password. After migration, verify the user accounts. 
As an Administrator, you can change password to a 
default password that complies with your organization’s 
user account policies.

Devices • Name changes. During file migration, the software 
changes the device names in the migrated files. Verify 
the device name changes in the protocols and device 
files before running any protocols. See the following 
table for a list of name changes.

• Vertical Pipetting Station shelves. Standard, Reagent, 
and Shaking shelves can be migrated. The following 
shelves will be converted to Standard shelves and 
must be reconfigured after the migration: Filter, Servo, 
Tipbox, and Tip Chute.

• Device files. Before you can run a migrated protocol, 
the protocol must be associated with a device file.

Liquid class 
specifications

If no liquid class was specified in the VWorks3 software, 
the following VWorks3 VPrep parameters are moved into 
the Liquid Library after migration: Aspirate velocity, 
Aspirate acceleration, Dispense velocity, Dispense 
acceleration

JavaScript 
parameters

The latest VWorks software contains various enhancements 
that resulted in the renaming of some variables. Your 
scripts may require editing to make them work in the 
latest software. For guidance, contact Automation 
Solutions Customer Service.

Old name New name

Access2 Automated Microplate 
Loader

Automated Centrifuge Loader, or 
Centrifuge Loader

Bio IO BioCel I/O Interface

Delid Station (Vacuum), Tip Box 
Delidder

Vacuum Delid Station

PlatePierce Seal Piercing Station Microplate Seal Piercer

Shuttle Robot Microplate Rotator Shuttle

VCode Barcode Print and Apply 
Station

Microplate Labeler

Velocity11 Conveyor Microplate Conveyor
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Migrating a single protocol

IMPORTANT This procedure is for VWorks users that have Administrator or 
Technician privileges and are familiar with the file migration limitations for 
their particular system.

IMPORTANT The first time you start the VWorks software on the computer, a 
message appears stating that some settings from the previous software version 
were found. The message asks whether to migrate these settings. The message 
refers only to global settings, not to protocols. 

To migrate a single protocol:

1 Make sure you are prepared for file migration. See “Before attempting file 
migration” on page 7.

2 Start the VWorks software. 

3 Select File > Open.

4 Locate and select the protocol, and then click Open. 

5 When the warning appears stating that you are opening a protocol created 
in an older version, click OK. 

6 In the Browse for Folder dialog box, select a folder or create a new folder for 
the migrated protocols, and click OK. 

Velocity11 Phantom Human Robot Phantom Robot

Velocity11 Robot 3- Axis Robot

VMix Mixing Station Mixing Station

VPrep Pipetting System Vertical Pipetting Station

VShuttle Rotating Microplate Mover Rotator

VSpin Microplate Centrifuge Microplate Centrifuge

VStack Labware Stacker Labware Stacker

Old name New name

CAUTION Before you attempt to migrate a protocol, contact Automation Solutions 
Customer Service for guidance. Careful planning and preparation is required to optimize the 
migration process. Depending on your system configuration, additional firmware upgrades 
may be required to prevent damage to your devices. Make sure you are aware of any 
limitations or post-migration adjustment requirements. 
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The migration starts. All associated files (device, profiles, teachpoints, 
labware definitions, and liquid definitions) are migrated and the new files 
appear in the newly created destination folder. 

7 In the Migration Tool dialog box, read the message describing whether the 
migration was successful and any warnings that were encountered during 
the migration. Click OK.

8 In the VWorks software window, check the Log area for error messages. 

The VWorks software notifies you of any changes to task parameters that 
occurred during the VWorks software development. For example, auto tip 
tracking is available in the latest version but was not previously available.

9 Double- check the device file.

10 Verify the protocol is intact, and save the new protocol file.

Note: The new VWorks software installs default profiles. When you migrate a 
protocol, the software automatically migrates the associated profiles unless a 
naming conflict occurs. If a default profile has the same name as a profile that 
you created previously, the software displays a warning message. 

IMPORTANT After migration, you can modify the protocols to take advantage 
of new features in the VWorks software, such as looping, time constraints, and 
task groups.

Migrating a folder of files

IMPORTANT This procedure is for VWorks users that have Administrator or 
Technician privileges and are familiar with the file migration limitations for 
their particular system.

IMPORTANT The first time you start the VWorks software on the computer, a 
message appears stating that some settings from the previous software version 
were found. The message asks whether to migrate these settings. The message 
refers only to global settings, not to protocols. 
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To migrate a number of protocols stored in one folder:

1 Make sure you are prepared for file migration. See “Before attempting file 
migration” on page 7.

2 Start the VWorks software.

3 Select Tools > Migrate all files in a folder. The Migrate All Files in One folder 
dialog box appears.

4 Select the source and destination folders and click OK.

The migration starts. All associated files (device, profiles, teachpoints, 
labware definitions, liquid definitions) are migrated and the new files 
appear in the newly created destination folder. 

5 In the Migration Tool dialog box, read the message describing whether the 
migration was successful and any warnings that were encountered during 
the migration. Click OK.

Note: The new VWorks software installs default profiles. When you migrate 
protocols, the software automatically migrates the associated profiles unless a 
naming conflict occurs. If a default profile has the same name as a profile that 
you created previously, the software displays a warning message. 

6 Double- check the device files.

7 Verify the protocols are intact, and save the new protocol files.

CAUTION Before you attempt to migrate a protocol, contact Automation Solutions 
Customer Service for guidance. Careful planning and preparation is required to optimize the 
migration process. Depending on your system configuration, additional firmware upgrades 
may be required to prevent damage to your devices. Make sure you are aware of any 
limitations or post-migration adjustment requirements. 
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IMPORTANT After migration, you can modify the protocols to take advantage 
of new features in the VWorks software, such as looping, time constraints, and 
task groups.

Related information

For information about... See...

Different file types and how they 
are related

VWorks Automation Control User 
Guide

Setting up user accounts “Managing user accounts” on page 105

Devices supported by the VWorks 
software

VWorks Automation Control User 
Guide
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2
Defining labware

This chapter contains the following topics:

• “About defining labware with the Labware Editor” on page 14

• “Labware Editor overview” on page 16

• “Workflow for defining labware” on page 19

• “Opening the Labware Editor” on page 21

• “Adding a labware entry” on page 23

• “Setting general properties” on page 26

• “Setting microplate properties” on page 28

• “Setting tip and well properties for pipetting” on page 32

• “Creating and assigning labware classes” on page 34

• “Using labware classes example” on page 37

• “Adding a labware image” on page 40

• “Setting Centrifuge Loader properties” on page 41

• “Setting BenchCel Workstation properties” on page 42

• “Setting Bravo Platform properties” on page 46

• “Setting Stacker properties” on page 48

• “Setting Direct Drive Robot properties” on page 51
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About defining labware with the Labware Editor

Labware defined

Labware is a physical object such as a microplate, lid, or tipbox that will be 
acted upon by the tasks stored in your protocol.

The VWorks software requires all labware that will be handled by the 
automation system to be defined in the labware database.

Labware entry defined

A labware entry is the collection of properties or parameter values that 
describe a specific type of labware. This information is used by the VWorks 
software to command the robot and other devices to do tasks based on the 
information in the definition.

All labware parameters are entered and accessible through the Labware Editor.

Labware Editor defined

The Labware Editor is the VWorks software interface through which you can 
enter information about labware.

You must be logged in as an administrator or technician to use the Labware 
Editor.

Types of information stored

Two main types of information are stored in the labware database:

• Information about the labware properties

• Information about labware classes

About labware properties or parameters

Labware has physical properties such as width, length, and number of wells. 
Labware can also have non- physical properties, such as robot- handling speed, 
robot grip offsets, and microplate- handling options.

After labware is defined in the Labware Editor, all you have to do is select the 
type of labware to use each time you set up a protocol.

About labware classes

Labware classes are sets of labware entries, grouped so they are easier to 
manage than many individual labware entries.

Labware classes are used in combination with the device manager to restrict 
which types of labware can be used on which devices during a protocol run. 
This prevents wasted runs and damage to the devices on the platform.

An example of how damage can be prevented by labware restriction is where a 
tipbox that is too tall for a device crashes into the device as the robot delivers 
it. 
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Related information

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Overview of the Labware Editor “Labware Editor overview” on page 16

Opening the Labware Editor “Opening the Labware Editor” on 
page 21
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Labware Editor overview

Labware Editor tabs

The Labware Editor has two tabbed pages:

• Labware Entries. Provides tools for creating and editing labware 
definitions

• Labware Classes. Provides tools for creating and editing labware classes 
and the labware entries for each class. 

Labware Entries tab
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Sub-tabs
The Labware Entries tab contains the following sub- tabs that contain the 
properties associated with a labware entry.

Labware selection list
The labware selection list, which is the left- hand column, displays the list of 
labware definitions and allows you to select the labware entry that you want 
to edit.

                                                        

To find out more about… See…

Plate Properties tab “Setting microplate properties” on page 28

Pipette/Well Definition tab “Setting tip and well properties for pipetting” 
on page 32

Labware Classes tab “Using labware classes example” on page 37

Image tab “Adding a labware image” on page 40

Centrifuge Loader tab “Setting Centrifuge Loader properties” on 
page 41

BenchCel tab “Setting BenchCel Workstation properties” on 
page 42

Bravo tab “Setting Bravo Platform properties” on 
page 46

Stacker tab “Setting Stacker properties” on page 48

Direct Drive Robot tab “Setting Direct Drive Robot properties” on 
page 51
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Labware-Entry General Properties area
The Labware- Entry General Properties area displays the labware properties 
that apply across all sub- tabs.

Labware Classes tab

You use the Labware Classes tab to create labware classes and assign defined 
labware to a labware class.
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Related information

Workflow for defining labware

Labware standards and considerations

IMPORTANT All labware used with Agilent Technologies products must 
conform to the American National Standards Institute (ANSI) microplate 
standards. This includes deepwell and PCR plates. A group within the Society 
for Biomolecular Sciences (SBS) recommends and maintains the standards. 
Visit www.sbsonline.org for more information, or contact your labware's 
manufacturer.

Vertical Pipetting Station users. In addition to the ANSI standards for 
labware, Vertical Pipetting Station shelves 1 and 2 have a height restriction to 
ensure clearance for the pipette head. The maximum height of the labware that 
you can use on shelves 1 and 2 depends on several factors, such as the type of 
pipette head, tip size, and type of shelf. 

Note: The software displays an error message if you select a labware definition 
that exceeds the maximum allowable height for shelves 1 and 2. 

Workflow

The following table presents the sequence of steps to define labware for 
devices that use the VWorks software.

Note: Some of these steps may be omitted, depending on your system 
configuration.

For information about... See...

The Labware Editor “About defining labware with the 
Labware Editor” on page 14

Workflow for defining labware in 
the Labware Editor

“Workflow for defining labware” on 
page 19

Step For this task... See...

1 Add the labware entry to the 
Labware Editor.

• “Opening the Labware Editor” 
on page 21

• “Adding a labware entry” on 
page 23

2 Set the general properties of 
the labware.

“Setting general properties” on 
page 26
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Related information

3 Set the microplate properties. 

BioCel System 3- Axis Robot 
only. Set the robot gripper 
offset.

“Setting microplate properties” on 
page 28

4 Bravo Platform or Vertical 
Pipettor only. Set the pipetting 
properties.

“Setting tip and well properties for 
pipetting” on page 32

5 Assign the labware to a class. “Creating and assigning labware 
classes” on page 34

6 Optional. Add a labware image. “Adding a labware image” on 
page 40

7 Centrifuge Loader only. Set 
the robot gripper offset if using 
a Centrifuge Loader.

“Setting Centrifuge Loader 
properties” on page 41

8 BenchCel Workstation only. 
Set the robot and stacker 
gripping positions. 

“Setting BenchCel Workstation 
properties” on page 42

9 Bravo Platform only. Set 
properties for the Bravo 
gripper, if applicable.

“Setting Bravo Platform properties” 
on page 46

10 BenchCel Workstation and 
Labware Stacker only. Set the 
gripper and sensor settings and 
any microplate notch positions.

“Setting Stacker properties” on 
page 48

11 Direct Drive Robot only. Set 
the robot gripper offsets and 
the grip force.

“Setting Direct Drive Robot 
properties” on page 51

12 Save a new or edited labware 
entry.

“Adding a labware entry” on 
page 23

Step For this task... See...

For information about... See...

The Labware Editor • “About defining labware with the 
Labware Editor” on page 14

• “Labware Editor overview” on 
page 16

Opening the Labware Editor “Opening the Labware Editor” on 
page 21



21

2   Defining labware
Opening the Labware Editor

VWorks Automation Control Setup Guide

Opening the Labware Editor

About this topic

You use the Labware Editor when you want to view, add, delete, edit, or 
rename labware entries or labware classes. This topic explains how to open the 
Labware Editor from the Tools menu and protocol editor in the VWorks 
software. See the device user guide for details on how to open the Labware 
Editor from the device diagnostics software. 

Before you start

You must be logged in as an administrator or technician to open the Labware 
Editor.

If you are adding labware, make sure you have the following:

• Calipers

• Two samples of the labware you are adding

Procedure

To open the Labware Editor from the Tools menu:

In the VWorks window, choose Tools > Labware Editor. The Labware Editor 
window opens.
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To open the Labware Editor from the protocol editor:

1 Open a protocol file (File > New > Protocol or File > Open). This opens the 
Main Protocol area with Process- 1 and a list of Plate properties in the 
Task Parameters area. 

Note: If the Task Parameters area is empty, click Add Process in the Main 
Protocol area.

2 Select Edit labware from the Plate type list under Plate identity. 

Related information

For information about... See...

The Labware Editor • “About defining labware with the 
Labware Editor” on page 14

• “Labware Editor overview” on 
page 16

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Adding a labware entry “Adding a labware entry” on page 23
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Adding a labware entry 

Before you start

You must be logged in as an administrator or technician to perform this 
procedure.

Before you add a new labware entry:

• Check to see if it is already defined in the Labware Editor. 

Some common labware and some Agilent Technologies labware comes 
already defined in the VWorks software.

• Contact Automation Solutions Technical Support with the definition you 
need.

Automation Solutions Technical Support maintains a large collection of 
labware definitions and might be able to supply you with what you need. 
However, these labware definitions will still require some fine- tuning for 
each particular system. The generic definitions available for some 
microplate types are a good starting point.

To find out if a type of microplate is already defined:

1 In the VWorks window, click Main Protocol, and select the microplate icon in 
a process.

2 In the Plate identity area, click the Plate type list and look for the microplate 
name.

If the list does not contain an entry for the microplate type, it is not yet 
defined.
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Procedure

To add a labware entry:

1 Open the Labware Editor.

2 In the Labware Entries tab, click New labware entry at the bottom left of the 
window.

Note: You can save time by using a definition for a similar labware type 
as a template. Select the pre- existing definition in the list, click Save 
changes as, and enter a name for the new labware definition.

3 In the New Labware Entry dialog box, type a name for the labware type, and 
click OK.

For clarity, enter a detailed name for the labware that includes labware-
specific information. For example, the name should include the number of 
wells, the manufacturer’s name and part number, and descriptive terms, 
such as square- well, flat- bottom or tipbox.

The new entry appears in the labware list. 

To save the labware entry:

1 Edit the properties as appropriate for the labware type. See “Workflow for 
defining labware” on page 19.

2 Click Save changes to save the newly defined labware entry.
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Related information

For information about... See...

The Labware Editor • “About defining labware with the 
Labware Editor” on page 14

• “Labware Editor overview” on 
page 16

Plate Properties tab “Setting microplate properties” on 
page 28

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Opening the Labware Editor “Opening the Labware Editor” on 
page 21
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Setting general properties

About general properties

The general properties describe the type of labware that is being entered into 
the database and are visible on all of the sub- tabs of the Labware Editor.

Before you start

• You must be logged in as an administrator or technician to perform this 
procedure.

• You must first create an entry for the labware.

Procedure

To define the general properties of a piece of labware:

1 Open the Labware Editor.

2 In the Labware Entries tab, select the labware from the list.

3 Under Labware-Entry General Properties, type a detailed description of the 
labware in the Description box.

4 In the Manufacturer part number box, type the appropriate number for your 
reference. 

5 In the Number of wells list, select the number of wells in the microplate. 
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If you are defining a tipbox, this is the number of tips that the box can 
hold.

6 In the Base Class area, select one of the options.

The option you select determines which Labware Editor properties are 
available. For example, when a base class of Microplate is selected, the 
Length of filter tip/pin tool (mm) property is unavailable.

Note: The Pin tool base class is not used.

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Setting microplate properties for 
labware

“Setting microplate properties” on 
page 28
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Setting microplate properties

Before you start

You must have a technician or administrator user account to perform this 
procedure.

Setting microplate properties

To set microplate properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Plate Properties sub- tab.

Figure Plate Properties sub-tab

3 Enter the values for the available parameters according to the labware type 
you are defining. The following table describes each parameter.

Note: The Base Class you select in the General Properties section 
determines which microplate properties are available.



29

2   Defining labware
Setting microplate properties

VWorks Automation Control Setup Guide

Parameter Description

Robot gripper 
offset (mm)

Note: Applies to the 3- Axis Robot in the BioCel Systems 
only. The Direct Drive Robot ignores this value, and uses 
the gripper offset values on the Direct Drive Robot tab.

The height (mm) of the gripper above any teachpoint 
when the VWorks software is picking up or placing a 
microplate of this type. The value is typically 0–3 mm.

Note: The offset could be a negative value, indicating it is 
below the teachpoint.

This parameter is used by the VWorks software when 
running protocols. The gripper offset parameter in the 
device Diagnostics software performs the same function 
when picking and placing labware using commands in 
the Diagnostics software.

Thickness 
(mm)

The distance from the bottom of the microplate skirt to 
the top of the microplate.

For a tipbox, this is the distance from the bottom of the 
box to the top of the tips.

To increase the number of contact points, measure the 
distance at the corner of the microplate or tipbox (using 
calipers). This method prevents the calipers from angling 
inward, which can produce inaccurate measurements.

Stacking 
thickness 
(mm)

The thickness of two stacked microplates minus the 
thickness of one microplate.

Measure the distance using calipers.

Example:

Thickness of two stacked microplates (x) = 23.14 mm

Thickness of one microplate = 14.14 mm

Stacking thickness: 23.14 mm -  14.14 mm = 9.00 mm

Vstack
plate and stacking thickness
00022

Plate Thickness

Stacking Thickness

x

00022
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Shim/nesting 
thickness

The distance between the bottom of the microplate skirt 
and the exterior bottom of the wells. (Shown as c below.)

Can be 
sealed?

The option to include the microplate seal. 

Sealed 
thickness 
(mm) 

The thickness of the microplate with a seal in place.

Available only if Can be sealed? is selected.

Sealed 
stacking 
thickness 
(mm)

The stacking thickness of the microplate with a seal in 
place.

Available only if Can be sealed? is selected.

Can have lid? The option to include a microplate lid.

Lidded 
thickness 
(mm)

The thickness of the microplate with a lid in place.

Available only if Can have lid? is selected.

Lidded 
stacking 
thickness 
(mm)

The stacking thickness of the microplate with the lid in 
place.

Available only if Can have lid? is selected.

Lid gripper 
offset (mm)

The height (a) above the lid resting height (b) at which 
the gripper can grip the lid.

Lid resting 
height (mm)

The height (c) above the bottom of the microplate (d) at 
which the bottom of a microplate lid rests. 

Parameter Description

Skirt C

a
b

c
d
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Lid departure 
height (mm)

The height (e) above the lid resting height to which the 
lid is lifted.

Plate Handling 

Lower plate 
at Microplate 
Labeler

The option to lower the microplate on the Microplate 
Labeler stage if the microplate has a thick skirt. This 
allows the Microplate Labeler to place the label above the 
thick skirt.

Can mount The option to place this microplate on top of another 
microplate.

This property is for filter plates that are placed on top 
of waste plates during filtration steps of a protocol.

This option can also be used to mount lids onto 
microplates.

Can be 
mounted

The option to place another microplate on top of this 
microplate.

This property is for collection microplates that collect 
filtrate from filter plates during the filtration steps of a 
protocol. Many different microplates might be able to fit 
under any one type of filter plate. 

IMPORTANT The wells of the waste plate must have a 
large enough diameter that the filter plate does not stick 
on the waste plate. The robot must be able to pick up 
the filter plate without the waste plate lifting up with it.

This option can also be used to mount lids onto 
microplate.

Maximum Robot Handling Speed

Maximum 
robot 
handling 
speed

The maximum speed at which the robot can move this 
type of microplate.

In addition to this microplate- specific speed, you set the 
general robot speed via the Tools > Options menu in the 
VWorks software. If these speeds are different, the robot 
uses the slower of the two speeds.

Note: To increase throughput, you can use a higher speed 
when the robot is not carrying labware. For details, see 
the VWorks Automation Control User Guide.

Miscellaneous

Length of 
filter tip/pin 
tool (mm) 

The length the filter nozzle extends below the bottom 
edge of the skirt. Use a caliper to measure the length.

Parameter Description

e
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Related information
 

Setting tip and well properties for pipetting

When to set the pipetting properties

If the VWorks software is controlling a Vertical Pipetting Station or a Bravo 
Platform, you must set the properties for the labware type in the Pipette/Well 
Definition sub- tab. 

Setting properties

To set pipette/well properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Pipette/Well Definition sub- tab.

Requires 
insert

The option to require an insert for use with nestable 
tipboxes.

Parameter Description

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Setting general properties for 
labware

“Setting general properties” on page 26

Setting Direct Drive Robot 
properties for labware

“Setting Direct Drive Robot properties” 
on page 51
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Figure Pipette/Well Definition sub-tab

3 Enter the values for the available parameters according to the labware type 
that you are defining. The following table provides a description of each 
parameter. 

 IMPORTANT Use calipers to carefully measure the labware you are 
defining in the Labware Editor.

Parameter Description

Well volume Maximum volume (µL) of fluid for one well.

Well depth Distance (mm) from the top of the microplate to 
the bottom of the well.

Well diameter Diameter of the well (mm).

Well Geometry Shape of the wells: round or square.

Well- Bottom Shape Shape of the well bottoms: rounded, flat, or 
V- shaped.

Row- wise 
teachpoint to well

Distance (mm) from the teachpoint to the center of 
the A1 well along the row (letter axis). 

This setting should be 0 mm for standard 96- well 
microplates and 2.25 mm for standard 384- well 
microplates.

Column- wise 
teachpoint to well

Distance (mm) from the teachpoint to the center of 
the A1 well along the column (number axis). 

This setting should be 0 mm for standard 96- well 
microplates and 2.25 mm for standard 384- well 
microplates. 
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Related information

Creating and assigning labware classes

About labware classes 

When you configure a device for the VWorks software, you can associate the 
device with labware classes to indicate what labware can (and cannot) be used 
with the device. Associating a device with a labware class is performed in the 
device file under the Allowed/prohibited labware property.

For example, if you have a Microplate Vacuum Alignment Station on a Bravo 
platform, you might want to set up a labware class from which tube racks are 
excluded. (Most types of tube racks will cause an error on the Microplate 
Vacuum Alignment Station).

VWorks software is provided with six labware classes already defined: 

• Uses Filter Platepad

• Uses Standard Platepad

Row- wise well to 
well

Distance (mm) from well- center to well- center 
across the row. 

This setting should be 9 mm for standard 96- well 
microplates and 4.5 mm for standard 384- well 
microplates. 

Column- wise well 
to well

Distance (mm) from well- center to well- center 
across the column. 

This setting should be 9 mm for standard 96- well 
microplates and 4.5 mm for standard 384- well 
microplates. 

Disposable tip 
capacity

Volume capacity (µL) of the disposable tips when 
labware is a tipbox. 

Disposable tip 
length

Length (mm) of the disposable tips being used 
when labware is a tipbox.

Parameter Description

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Setting general properties for 
labware

“Setting general properties” on page 26

Setting microplate properties for 
labware

“Setting microplate properties” on 
page 28
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• Uses Taller Plate

• Uses Tip Box

• Uses Vacuum Delidder

• Uses Vacuum Platepad

These default classes should be enough for your microplate handling needs. 
However, if you want an additional special class that is excluded from a 
particular device or set of devices, you can create a new class.

About creating and assigning labware classes

The Labware Classes tab in the Labware Editor provides the tools for creating 
and managing labware classes and labware entry membership. 

Select a class (in the left- most column) to see the labware entries that are 
members and non- members for that class (right two columns). In the example 
below, the class Uses Filter Platepad is selected and the labware that are 
members and non- members of this class are displayed.
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Creating labware classes

To create a new labware class:

1 Open the Labware Editor.

2 In the Labware Classes tab, click New labware class.

3 In the New Labware Class dialog box, enter a name for the labware class and 
click OK.

The class appears in the list of labware classes. 

Note: You can also create a new labware class by clicking Save changes as and 
entering a different name.

Assigning labware classes

To associate a specific piece of labware with a labware class:

1 Open the Labware Editor.

2 In the Labware Classes tab, select an item from the middle column.

3 Click > to move the labware entries or labware classes to the right- hand 
column.

To select more than one item, use SHIFT+click or CTRL+click. If you want 
to move all entries, click >>. 

4 Click Save Changes to save your changes. 

Note: You can also assign labware to a class using the Labware Classes tab on 
the Labware Entries tab. This may be more convenient when you are defining 
a new piece of labware and want to assign it to an existing labware class.

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

An example demonstrating the use 
of labware class

“Using labware classes example” on 
page 37
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Using labware classes example

Example

You have configured shelves 2, 4, and 6 of a Vertical Pipettor as devices that 
are accessible by the system’s robot. You are using a mix of microplates, some 
of which are too tall to fit on shelf 2. By using labware classes, you will 
ensure that the robot will never try to place the wrong type of labware on 
shelf 2.

The labware has been defined and added to the Labware Editor but it still has 
the default settings for class membership. 

You need to:

1 Assign the tall labware to the appropriate labware class.

2 Restrict shelf 2 from using any labware that is a member of the Uses Taller 
Plates class.

Assigning the labware to a labware class

To assign the labware:

1 Open the Labware Editor.

2 In the Labware Entries tab, select the labware from the list, and then click 
the Labware Classes sub- tab. The classes that the labware are and are not a 
member of is displayed.

3 Select Uses Taller Plates from the All labware classes area, and then click > to 
move the class to the Labware classes that this labware entry belongs to area.

4 Click Save changes.
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Setting restrictions for shelf 2

To restrict shelf 2:

1 In the VWorks window, open the device file, and ensure the correct Vertical 
Pipetting Station device is selected.

2 In the Devices list under Vertical Pipetting Station, select Shelf 2.

3 Under Shelf 2 Location Properties, click the Allowed/prohibited labware field, and 
then click the  button. The Allowed/Prohibited Labware Classes dialog 

box opens.

4 In the Unassigned labware classes area, select Uses Taller Plates, and then 
click < to move it to the Labware classes prohibited from using this device area.

5 Click OK.
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Figure VWorks software main window (partial) and Allowed/Prohibited Labware Classes 
dialog box.

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Labware classes “Creating and assigning labware 
classes” on page 34
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Adding a labware image

About labware images

To make it easier for operators to identify a labware type, you can insert an 
image of it in the Labware Editor.

Before you start

Make sure the image file you want to add is either the JPG, GIF, or BMP 
format.

Procedure

To insert an image:

1 Open the Labware Editor.

2 In the Labware Entries tab, select the labware in the left column, and then 
click the Image sub- tab. 

3 At the Image filename box, click the  button to locate the file.

4 In the Open dialog box, select the image file and click Open.

The image appears below the file name.

5 Click Save changes.
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Related information

Setting Centrifuge Loader properties

When to set Centrifuge Loader properties

If you are operating a Centrifuge with an Centrifuge Loader, set the 
corresponding properties in the Centrifuge Loader sub- tab of the Labware 
Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Procedure

To set Loader properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Centrifuge Loader sub- tab.

3 In the Robot gripper offset (mm) box, type the distance from the bottom of 
the microplate where the robot can grip the microplate.

4 Optional. Select the Ignore plate sensor during pick and place check box if you 
want to ignore the microplate sensor, for example if you are using a black 
microplate that has a finish and skirt that would otherwise avoid detection.

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Using the Labware Editor “Labware Editor overview” on page 16

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Using the Labware Editor “Labware Editor overview” on page 16
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Setting BenchCel Workstation properties

About the BenchCel Workstation properties

The BenchCel Workstation X- Series and R- Series each have their own gripper 
offsets and positions. When you add a new labware entry, default parameter 
values are automatically inserted for both series. These values are approximate 
and should be ignored because the labware you are defining may be different.

Any labware that you are using with the X- Series must be redefined to work 
with the R- Series BenchCel Workstation because the parameter values are 
different for the same piece of labware. 

Note: You must also define a subset of the Stacker properties (under the 
Stacker sub- tab) because they apply to the built- in stackers of the BenchCel 
Workstation.

Procedure

To define the BenchCel Workstation properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the BenchCel sub- tab.

Figure BenchCel sub-tab

3 Click the button that corresponds to the BenchCel Workstation type that is 
currently operating and for which you are defining the labware.
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 IMPORTANT Make sure you enter values for the correct model of the 
BenchCel Workstation. Fields for X- Series and R- Series BenchCel 
Workstations can be enabled regardless of the type of BenchCel 
Workstation that you are operating.

4 Measure the labware and enter the values for the following fields.

Parameter Description

Robot gripper offset 
(mm)

The distance from the bottom of a microplate to 
where the robot grippers will hold the microplate.

IMPORTANT Make sure that the gripper points 
do not close at the edge of the skirt. Otherwise, 
the gripper can slip onto the body of the 
microplate and drop the microplate.

Gripper open position 
(mm)

The distance the grippers move from the home 
position as the robot releases a microplate. A 
larger value moves the grippers closer together. A 
smaller value opens the grippers wider.

Set this to –1 for R series and 0.1 for X Series 
BenchCel Workstations.

Gripper holding plate 
position (mm)

The distance that the grippers move inward from 
their home position when holding a microplate 
that is not in a stack. A larger value moves the 
grippers closer together and holds the microplate 
tighter. A smaller value opens the grippers wider.

Note: How tightly the robot grippers should hold a 
microplate depends on the microplate material 
and design. You might want to run some tests to 
optimize the parameter.
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Gripper holding lidded 
plate position (mm) 

The distance that the grippers move inward from 
home position when holding a lidded microplate. 

An increasing value moves the grippers closer 
together and holds the lidded microplate tighter. 
A decreasing value opens the grippers wider.

Gripper holding lid 
position (mm)

The distance the grippers move inward from 
home position when holding a microplate lid. 
Increasing the value moves the grippers closer 
together and holds the lid tighter. Decreasing the 
value opens the grippers wider.

In general, type a value that is less than Gripper 
holding plate position to open the grippers 
slightly. Holding the lid too tightly might cause 
the microplate to be lifted with the lid.

Gripper holding stack 
position (mm)

The distance the grippers move inward from the 
home position when holding a microplate that is 
in a stack. A larger value moves the grippers 
closer together and holds the microplate tighter. A 
smaller value opens the grippers wider.

Note: Because the weight of the entire stack will 
be on the robot grippers, you should use a value 
greater than the Gripper holding plate parameter.

Stacker gripper offset 
(mm)

The distance from the bottom of a microplate to 
where the stacker grippers will hold the 
microplate.

Be careful not to grab the microplate on the top 
edge of the skirt where the stacker grippers could 
slip onto the microplate body.

Change this value only if the stacker is not 
gripping the microplates correctly.

Orientation sensor offset 
(mm)

The distance from the bottom of a microplate to 
where the orientation sensors will check for 
notches. 

You can calculate the initial offset as follows: 
Determine the halfway distance between the top 
of the microplate and the top of the microplate 
skirt, and then add the height of the skirt.

See the BenchCel Microplate Handling 
Workstation User Guide for details on how to 
determine the optimum Orientation sensor offset. 

Parameter Description

Divide this height by 2

Add the skirt height
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Related information

Stack holding method R- Series only. The option that specifies how the 
stacker holds the stack of microplates: 

• Hold with stacker gripper. For the greatest 
precision, select this method, for example, if 
your microplate has a narrow gripping 
tolerance requiring a specific stacker gripper 
offset. Holding the stack with grippers results 
in slower cycle time than the Hold with shelf 
method.

• Hold with shelf. For faster cycle time, select 
this method if your microplate has a wider 
gripping tolerance and does not require a 
specific stacker gripper offset.

Parameter Description

For information about... See...

Using the Labware Editor “Labware Editor overview” on page 16

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Setting general properties for 
labware

“Setting general properties” on page 26
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Setting Bravo Platform properties

When to set Bravo properties

If you are operating a Bravo Platform that has a robot gripper, use this 
procedure to ensure that the parameter values are set correctly.

Note: The Bravo robot gripper is an optional feature.

You must be logged in as an administrator or technician to perform this 
procedure.

Procedure

To set Bravo Platform properties:

1 Open the Labware Editor.

2 In the Labware Entries tabs, click the Bravo sub- tab.

3 Under Gripper Offset and Positions, type the Robot gripper offset. This is the 
height (mm) of the gripper above any teachpoint when the Bravo gripper is 
picking up or placing a microplate of this type.

4 Enter the Robot lid gripper offset. This is the height (mm) above the lid resting 
height at which to grip the lid. (Shown as b below.)

5 Select Ignore plate sensor during pick and place to tell the robot gripper to 
ignore the feedback from the microplate sensor during a pick and place for 
this labware. Typically, this is selected when troubleshooting.

                                                        

b
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Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Using labware classes “Creating and assigning labware 
classes” on page 34
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Setting Stacker properties

When to set Stacker properties

If you are using a Stacker or a BenchCel Workstation in your automation 
system, you must set the properties in the Stacker sub- tab of the Labware 
Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Before you start

BenchCel Workstation users. Make sure you have read the sections of the 
BenchCel Microplate Handling Workstation User Guide that describe the 
location and function of the stacker sensors.

Setting properties

To set stacker properties:

1 Open the Labware Editor.

2 In the Labware Entries tab, click the Stacker sub- tab. 

3 Enter the values for the available properties according to the labware you 
are defining. 

BenchCel Workstation only. Set only the maximum orientation sensor 
threshold, sensor intensity, and notch locations. The other settings are used 
by the Stacker.

Figure Properties required for the BenchCel Workstation 
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The following table provides descriptions of each parameter. 

Parameter Description

Stacker only. 
Stacker gripper 
offset 

Adjusts the height at which the microplate stage 
stops for the grippers to grip the microplate, with 
respect to the Stacker’s grip teachpoint.

Change this value only if the stacker is not 
gripping the microplates correctly.

Stacker only. 
Presentation offset 

You should never need to change this value.

Adjusts the height of the Stacker plate stage with 
respect to the presentation teachpoint of a 
Stacker.

Stacker only. 
Orientation sensor 
offset

Adjusts the height at which the orientation 
checking sensors view the microplate, with respect 
to the sensor.

Orientation sensor 
threshold (max)

Specifies the highest value that an orientation 
sensor can register when sensing a notch. Any 
sensor reading above this value indicates that a 
solid microplate wall is present. Any sensor value 
below this threshold indicates that either a notch, 
or no microplate is present.

If the stacker does not sense a notch when it 
should, you will get a “wrong plate type” or a 
“plate rotated 180 degrees” error message. Adjust 
the sensor threshold value.

The maximum value is 255.

Stacker only. 
Orientation sensor 
threshold (min)

Indicates whether a microplate was downstacked 
or is present on the stage.

This threshold specifies the lowest value that an 
orientation sensor can register and still consider a 
notch to be present. 

If the orientation sensor returns a value below 
this threshold, an error message appears stating 
that no microplate is present on the stage.

If the stacker does not sense a notch when it 
should, a “wrong plate type” or a “plate rotated 
180 degrees” error message appears. In this case, 
adjust the sensor threshold value.

Sensor intensity Sets the percentage of maximum sensor intensity 
for all sensors. If the sensor intensity is set too 
low, a microplate will not be detected even though 
one is present. If it is set too high, the sensors 
might become saturated, causing failure to detect 
the orientation of a microplate.

This parameter adjusts for the fact that clear, 
black, and white microplates reflect light 
differently. For example, white microplates 
generally reflect more light so the sensor intensity 
should be set lower. 
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Related information

Stacker only. Use 
vacuum clamp

Instructs theStacker you are using a vacuum 
clamp in the Stacker stage to grasp the microplate 
during delidding.

Notch Locations • Check orientation. Turns on microplate-
orientation checking based on the selected 
notch locations for your microplate. The notch 
locations are ignored when this check box is 
cleared.

• Notch location check boxes. Select the 
corresponding notch or notches for your 
microplate.

For BenchCel Workstations, the A1 well of the 
microplate is positioned in the far, left corner as 
you face the front of the BenchCel Workstation.

For BioCel Systems, the A1 well of the microplate 
is positioned in the far, left corner from the 
perspective of the robot.

IMPORTANT The Stacker has only two 
orientation sensors for detecting notches. If the 
wrong microplate is loaded and an orientation 
sensors detect notches, the sensors will not flag 
an incorrect orientation for the wrong microplate.

IMPORTANT If the orientation sensors detect 
notches in the correct location, the sensors will 
not flag an incorrect orientation for the wrong 
microplate.

Parameter Description

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Notches

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Using the Labware Editor “Labware Editor overview” on page 16
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Setting Direct Drive Robot properties

When to set Direct Drive Robot properties

If you are using the Direct Drive Robot in your automation system, you must 
specify the robot properties for the labware that the robot will handle. Because 
the weight, material, and design varies, you specify the properties for each 
labware type.

You must be logged in as an administrator or technician to perform this 
procedure.

About the robot gripper offset properties

The robot gripper offset parameters tell the Direct Drive Robot where to grip a 
given labware type when transferring it from one device to another. Each 
device within a system can pose different accessibility challenges when 
transferring the labware. For example, some devices can have a deep, recessed 
area, whereas others are more flat.  Some devices might have tall flanges that 
make it impossible for the robot to grip a microplate at a very low point.

The Direct Drive Robot uses three types of gripper offset ranges to determine 
the most compatible grip position for the labware type:

1 Gripper offset range for the labware. Specified on the Direct Drive Robot 
tab in the Labware Editor for each labware definition. 

2 Gripper offset range for pick- location device. Specified in the DD Robot 
Diagnostics software for a given device (device A).

3 Gripper offset range for place- location device. Specified in the DD Robot 
Diagnostics software for a given device (device B).

If the three gripper offset ranges overlap, the robot can use the smallest 
common gripper offset to perform a direct labware transfer from device A 
to device B without regripping the labware. If the three ranges do not 
overlap, the software attempts to plan a path through one or more regrip 
stations. If the robot cannot perform the transfer without risking a physical 
collision, an error message appears at the time of the requested labware 
transfer and the run cannot continue.

To provide the system with the greatest flexibility for identifying a grip 
position that works for all locations, you should set the widest possible range 
for each gripper offset parameter.
 

To set Direct Drive Robot properties:

1 Open the Labware Editor. 

2 In the Labware Entries tab, click the Direct Drive Robot sub- tab.
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Figure Direct Drive Robot sub-tab

3 Enter the values for the following properties according to the labware type 
that you are defining. 

Parameter Description

Landscape gripper 
offset (mm) 

• Minimum. The distance from the bottom of the 
microplate to the lowest point where the robot 
grippers can hold the microplate in landscape 
orientation. Default: 0 mm

• Maximum. The distance from the bottom of the 
microplate to the highest point where the robot 
grippers can hold the microplate in landscape 
orientation. Default: 10 mm

The minimum and maximum values depend on the 
given microplate features and the robot gripper 
arms, which are 3 mm tall. For example, if the 
microplate has a 4- mm tall skirt, you could set the 
gripper offset range from 0 mm (minimum) to 
2 mm (maximum). At the minimum, the gripper 
will be flush with the bottom of the microplate, 
while at the maximum the robot can still grip the 
microplate securely.
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Related information

Portrait gripper 
offset (mm)

• Minimum. The distance from the bottom of the 
microplate to the lowest point where the robot 
grippers can hold the microplate in portrait 
orientation. Default: 0 mm

• Maximum. The distance from the bottom of the 
microplate to the highest point where the robot 
grippers can hold the microplate in landscape 
orientation. Default: 10 mm

The long sides of some microplates have a raised 
section in the middle of each side. In this case, set 
the minimum gripper offset higher than the uneven 
surface to ensure that the robot can grip the 
microplate evenly and securely. The following 
example shows how the range can vary depending 
on the microplate features.

Grip torque 
percentage

The grip force with which the robot grips the 
microplate, where 100% is the maximum gripping 
force. A smaller value grips the microplate with 
less force than a greater value.

The force with which the robot can grip a 
microplate depends on the microplate weight, 
material, and design. You should run some tests to 
optimize the setting.

Parameter Description

Maximum

Minimum

Maximum
Minimum

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 19

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Using the Labware Editor “Labware Editor overview” on page 16

Direct Drive Robot www.agilent.com/lifesciences/automation

http://www.agilent.com/lifesciences/automation
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3
Specifying pipette speed and accuracy

This chapter contains the following topics:

• “About liquid classes” on page 56

• “Opening the Liquid Library Editor” on page 58

• “Creating a liquid class” on page 59

• “Calibrating the pipettor” on page 62
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About liquid classes

Liquid Library Editor defined

The Liquid Library Editor provides tools for users with technician or 
administrator privileges to enter values for properties that affect pipetting 
speed, accuracy, and precision. 

Figure Liquid Library Editor window

Default liquid library entries

When installing VWorks software, you might have elected to install the default 
liquid library entries. These entries are provided as examples and thus might 
only approximate your particular reagents. For the best performance, you 
should create your own liquid library definitions.

When to use the Liquid Library Editor

You use the Liquid Library to fine- tune the volume aspirated or dispensed by 
your Bravo Platform or Vertical Pipetting Station.

IMPORTANT Verify the pipetting of your Bravo Platform or Vertical Pipetting 
Station. Accurate and precise pipetting depends on a variety of factors 
including the liquid properties. 

Liquid classes defined

The values entered into the Liquid Library Editor can be saved as a collection, 
known as a liquid class. Using liquid classes saves time when writing protocols 
because you do not have to enter values for the liquid properties every time 
you create a protocol.

Types of liquid classes 
You might want to create different classes for different:

• Types of liquids
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For example, water versus DMSO

• Volumes of liquids

For example, 1 µL versus 200 µL

• Liquid operations

For example, washing versus mixing

Liquid library database defined

The data that represents a liquid class is saved to the liquid library database, 
which is maintained in the Windows registry.

Using a liquid class

When preparing for a protocol run, you select the liquid class that you want to 
use. During the run, the liquid class values are referenced for pipetting 
operations.

Calibrating the Bravo Platform and Vertical Pipetting Station

The Liquid Library Editor also has an equation editor that can be used to 
calibrate the Bravo Platform and Vertical Pipetting Station.

Related information

For information about... See...

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 58

Creating a liquid class “Creating a liquid class” on page 59

Calibrating your pipettor “Calibrating the pipettor” on page 62
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Opening the Liquid Library Editor

Before you start

You must be logged in as an administrator or technician to open the Liquid 
Library Editor.

Procedure

To open the Liquid Library Editor from VWorks software:

1 Select Tools > Liquid Library Editor.

The Liquid Library Editor opens.

Related information

For information about... See...

Liquid classes “About liquid classes” on page 56

Creating a liquid class “Creating a liquid class” on page 59

Calibrating your pipettor “Calibrating the pipettor” on page 62
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Creating a liquid class

About this topic

This topic describes how to create a liquid class using the Liquid Library 
Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Liquid compatibility

Procedure

To create a liquid class:

1 Open the Liquid Library Editor.

2 Click New liquid entry. 

3 In the New Liquid Entry dialog box, type a name for the liquid class and click 
OK.

4 Optional. In the box at the top right of the Liquid Library Editor window, type 
a note describing the entry for your records.

5 On the Aspirate tab, type the values for the following aspirate parameters.

WARNING  Agilent Technologies products are intended to be used with non-hazardous 
liquids. Please contact Automation Solutions Technical Support before using any non-
aqueous solvents or solvents generally considered to be hazardous. 
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Note: The upper limits for some of the parameters might not be 
achievable for the device you are using. 

6 Click the Dispense tab and enter values for the dispense properties.

The following table describes the dispense parameters.

Aspirate Definition

Velocity (µL/s) Specifies the speed of the aspiration stroke.

Acceleration (µL/s2) Specifies acceleration during the aspiration 
stroke.

Post- aspirate delay (ms) Specifies the time the pipettor waits after 
aspiration is complete before moving the 
tips out of the wells.

Z- axis velocity into wells 
(mm/s)

Specifies how fast the pipettor moves as 
the tips enter the wells.

Z- axis acceleration into 
wells (mm/s2)

Specifies the acceleration of the pipettor as 
the tips move into the wells. 

Z- axis velocity out of wells 
(mm/s)

Specifies how fast the tips leave the wells.

Z- axis acceleration out of 
wells (mm/s2)

Specifies the acceleration of the pipettor as 
the tips move out of the wells. 

Dispense Definition

Velocity Specifies the maximum speed 
of the dispensing stroke, in 
microliters per second.

Acceleration Specifies acceleration during 
the dispensing stroke, in 
microliters per second squared.
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7 Click Save changes. 

The changes are now stored in the liquid library database.

Related information

Post- dispense delay Specifies the time the pipettor 
waits after the dispense stroke 
before moving the tips out of 
the wells, in milliseconds.

Z- axis velocity into wells Specifies how fast the pipettor 
moves as the tips enter the 
wells, in millimeters per 
second.

Z- axis acceleration into wells Specifies the acceleration of 
the pipettor as the tips enter 
the wells, in milliliters per 
second squared.

Z- axis velocity out of wells Specifies how fast the pipettor 
moves as the tips leave the 
wells, in millimeters per 
second.

Z- axis acceleration out of wells Specifies the acceleration of 
the pipettor as the tips leave 
the wells, in millimeters per 
second squared.

Dispense Definition

For information about... See...

Liquid classes “About liquid classes” on page 56

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 58

Calibrating your pipettor “Calibrating the pipettor” on page 62
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Calibrating the pipettor

About calibrating the pipettor

You can improve the accuracy of pipetted volumes by:

• Calibrating the pipettor

• Plotting the actual volume dispensed as a function of the set dispense 
volume

• Calculating the polynomial coefficients of the plot

• Entering the coefficients into the liquid library equation editor

Do you need to calibrate your pipettor?

Pipetting accuracy is the ability to dispense an absolute volume of liquid. In 
practice, the volume that is actually dispensed by a pipettor may be different 
from the dispense volume that you select. This difference is the absolute error.

In some protocols, as long as you dispense an excess of liquid, the actual 
volume pipetted is not important. In other protocols, pipetting accuracy can be 
a critical factor. You must remember, though, that every step of an experiment 
has error and there is no point taking time to improve the accuracy of 
pipetting to four significant digits if another step in your protocol has error at 
the third significant digit.

If you are sure that the overall error of the experiment is limited by pipetting 
accuracy, and error at this number of significant figures makes a practical 
difference to you interpretation of the data, consider performing an accuracy 
calibration.

Method overview

This section gives an overview of the method you can use to measure pipetting 
accuracy. It does not give a detailed procedure because that depends on 
exactly how you choose to conduct the experiment.

To calibrate a pipettor, an independent method of measuring dispensed volume 
is required. One method is to dispense a solution of fluorescein dye and 
measure the fluorescence emitted from each microplate well.

IMPORTANT Whichever method you use, verify that the error in the detection 
method is significantly smaller than the pipetting error. Otherwise, the error 
you detect might be from the detection method and not the pipetting error.

The overall method is:

1 Perform a series of pipetting operations in which different volumes are 
pipetted.

2 Measure the volumes of dispensed liquid using the independent measuring 
method.

3 In a spreadsheet program, tabulate the dispense volumes that you set in 
the software against the measured volumes.

4 Plot a graph, with the set dispense volume on the y- axis and measured 
dispense volume on the x- axis.
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The plot will be a curve, reflecting the fact that absolute error is a 
function of the magnitude of the measurement.

5 Use the statistical functions of the spreadsheet program to fit a curve to 
the data.

Your result might look like this:

The dashed line is a reference line, where the set dispense volume equals 
the measured dispense volume. The equation is the polynomial for the line, 
calculated by the spreadsheet program.

6 Enter the curve information into the equation editor of the Liquid Library 
Editor.

If you repeat the experiment, you will find that the curve is much closer to a 
straight line. This is because the equation you entered adjusts the action of the 
servo motor that determines aspirate and dispense volumes, thereby calibrating 
the dispense.

Using the equation editor

You use the equation editor in the Liquid Library Editor to enter the 
calibration curve data and correct for pipetting inaccuracy.

To enter a polynomial into the equation editor:

1 Open the Liquid Library Editor.

2 Click the Equation tab to display the equation editor.

3 In the Highest order of polynomial text box, enter the value for the highest 
order of the polynomial.

This is the largest exponent in the equation and tells you how many terms 
are in the equation. For example, if the highest order of the polynomial is 
3, the equation will have the general form: y = a + bx +cx2 + dx3, where ‘x’ 
is the volume specified by any pipettor task that uses this liquid class. 
With an exponent of three, four rows are added to the equation editor 
table.

4 In the Coefficient/Term table, enter the coefficient and exponent for each 
of the terms in the equation, starting with the zero order term.

y = 9E-05x  + 0.0027x  + 1.0176x - 0.12373 2
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To enter a value, single- click the Coefficient table row twice. Note that the 
exponents are already entered for you and cannot be edited.

The following example is for the curve displayed in the previous graph.

5 Click Save changes.

Related information

For information about... See...

Liquid classes “About liquid classes” on page 56

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 58

Creating a liquid class “Creating a liquid class” on page 59
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4
Tracking and managing labware in 
storage

This chapter contains the following topics:

• “About labware inventory management” on page 66

• “Connecting to the inventory management database” on page 69

• “Opening the inventory editor” on page 71

• “About inventory groups” on page 72

• “Creating and managing location groups” on page 74

• “Creating and managing plate groups” on page 76

• “Loading labware into storage devices” on page 79

• “Moving labware between storage devices” on page 82

• “Unloading labware out of inventory” on page 85

• “Using a plate group to process labware” on page 88

• “Creating a plate group with a barcode input file” on page 93

• “Inventory editor views and filters” on page 95

• “Auditing plate volumes in the inventory editor” on page 97

• “Reinventorying the labware inventory” on page 100

• “Resolving labware inventory problems” on page 102
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About labware inventory management

About this topic

This topic provides the background information you need to understand how to 
use the labware inventory manager to track groups of microplates moving into 
and out of a microplate storage device.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX, Heraeus Cytomat PLC, or an Agilent Technologies Plate Hub 
Carousel and you are using, or want to set up, inventory management with a 
database. 

Before you start

Before creating protocols that use the storage device, make sure you have read 
the device driver user documentation for your particular storage device as well 
as “Resolving labware inventory problems” on page 102.

Barcode tracking versus inventory management

Barcode tracking
Barcode tracking without an inventory system is limited because the 
microplate locations are stored in memory and are lost when you exit the 
VWorks software. 

Inventory management
The inventory management system allows long- term tracking of microplates 
because barcode data is permanently stored in a database. This is useful for 
lab automation systems with devices that store microplates for a long time, 
such as a Heraeus Cytomat PLC and Liconic StoreX.

Required database

To use inventory management, you must have an SQL database set up, either 
on the computer that runs the VWorks software or a computer that is on the 
same local area network.

How microplates are stored

The long- term storage devices supported by the VWorks software store 
microplates in cassettes and slots. A cassette is a vertical rack that has many 
slots, with each holding one microplate.

Information that is stored

The inventory maintains a list of microplates located in a long- term microplate 
storage device.



67

4   Tracking and managing labware in storage
About labware inventory management

VWorks Automation Control Setup Guide

The information contained about each microplate in the inventory includes:

• Device in which the microplate is located

• Cassette and slot location of the microplate

• Name of the group or location to which it belongs

• Labware type

• Any north- side, south- side, east- side, and west- side barcodes

Note: West side barcodes are tracked only if an optional barcode reader 
is used. 

• Volume of the wells in the microplate

The list of microplates in the inventory is displayed in the Inventory Editor 
dialog box. An example view is shown below.

The list of microplates in the inventory is updated every time the robot moves 
a microplate into or out of a storage device. The list is current at all times.

Inventory manager

The Inventory Editor dialog box provides the tools for you to manage the 
labware inventory. From here you can:

• Create plate groups

• Create location groups

• Review information about labware in a group

• Import groups from a barcode file

• Change the labware type associated with labware in the database

• Delete labware from the database

• Inventory the labware in a storage device

Plate groups and location groups

With long- term storage devices, typically only a sub- set of the labware stored 
in the device is used in one protocol. You can set up two different types of 
labware sub- sets, called plate groups and location groups. Which you choose 
for a particular protocol depends on what you are planning to do.

A plate group is a group of labware based on the unique database identifier 
for that labware.

A location group is a group of slots that are not based on information in the 
labware database.
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Inventory management tasks

The following tasks are used with the inventory management system. These are 
the tasks that move labware in to and out of a storage device:

• Load

• Unload

• Incubate at microplate storage device

About manually moving labware

Keeping the database synchronized
The database cannot track labware that you manually add, remove, or move. To 
keep the database synchronized with the storage device, load and unload the 
microplate storage device robotically, or periodically reinventory the storage 
device.

Instead of manually adding labware to the storage device, write a protocol to 
downstack and load the labware. Instead of manually removing labware from 
the storage device, write a protocol to unload and upstack the labware.

If you must manually load and unload labware
If you must manually load and unload labware, create a protocol to load or 
unload the exact labware that you are manually adding or removing, and then 
simulate the protocol in the software.

With an appropriate protocol, the simulated run accurately changes the 
labware listed in the database without actually moving any labware. 

Terminology

The following terms are used to describe the movement of labware in the 
system.

Term Definition

Unload The act of moving labware from a storage device into the system.

Load The act of moving labware from the system into a storage device.

System Labware that are being processed by the current protocol are 
considered to be in the system.

For example:

• Labware on a platepad is in the system.

• Labware in a plate hotel is in the system.

• Labware being incubated in an incubator is in the system.

• Labware half- way up a Stacker rack is not in the system, 
unless it will be moved during the current protocol.

• Labware being stored in a Plate Hub Carousel is not in the 
system unless it will be moved during the current protocol.
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Database backup

The inventory management database can be backed up onto another computer 
using a software utility. Contact Automation Solutions Technical Support for 
more information about the software utility.

Related information

Connecting to the inventory management database

Who should read this

Read this topic if your lab automation system has a storage device, such as a 
Liconic StoreX, Heraeus Cytomat PLC, or Agilent Technologies Plate Hub 
Carousel, and you are using or setting up inventory management with a 
database. 

Setting up the database 

Before you can connect to the database, you must install and configure the 
inventory management database. To set up the inventory management 
database, contact Automation Solutions Technical Support for assistance.

Connecting to the database

The database connection is specified in the VWorks software.

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 72

Setting up the database “Setting up the database” on page 69

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88

Using barcode input files “Creating a plate group with a barcode 
input file” on page 93
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To connect to the database:

1 In the VWorks window, choose Tools > Options. The Options dialog box 
appears.

2 Under DB Setup, verify the following, and then click OK.

• Enable database connection is selected.

• Connection string is dsn=velocity11.

Note: Velocity11 is the factory- default database name specified in 
the ODBC. If you changed the name in the ODBC, you must update 
the Connection string field in the Options dialog box.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 72

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88

Using barcode input files “Creating a plate group with a barcode 
input file” on page 93

Specifying the database name in 
the ODBC

“Resolving labware inventory problems” 
on page 102
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Opening the inventory editor

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX, Heraeus Cytomat PLC, or an Agilent Technologies Plate Hub 
Carousel and you are using inventory management with a database.

Before you start

Before you can open the inventory editor, the inventory database that the 
editor communicates with must be installed and configured. 

Opening and closing the inventory editor

To open the inventory editor:

Select Tools > Inventory Editor.

Alternatively, select a Load or Unload task in a protocol and click Edit location 
groups or Edit plate groups.

To close the inventory editor:

Click  in the top- right corner of the window.

Related information

For information about... See...

Setting up the inventory 
management database

“Setting up the database” on page 69

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 72

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88

Using barcode input files “Creating a plate group with a barcode 
input file” on page 93
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About inventory groups

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Inventory groups defined

An inventory group is a group of labware or slots that is a subset of the 
labware listed in the inventory. 

Types of inventory groups

There are two types of inventory groups:

• Location group

• Plate group

Location groups

Location groups are used to move labware to and or from a specific location in 
the storage device.

Example:
In this example, a location group that contains slots 1–10 in cassette 1 is 
created. 

When an Unload task uses this location group, the robot moves whatever 
labware are in cassette 1, slots 1–10, regardless of the identity of the labware, 
out of the storage device and into the system. 

When a Load task uses a location group, it moves the labware that are in the 
system into cassette 1, slots 1–10 of the storage device, regardless of the 
identity of the labware.

When to use
Location groups are used when:

• The storage device is being filled or emptied.

• The groups of labware are removed from the lab automation system and 
replaced with other groups of labware on a regular basis. This would be 
done by replacing a cassette of labware with a new one.

Plate groups

Plate groups are used to move specific labware to or from the storage device, 
but without regard for the location. Plate groups can be used when operators 
do not routinely remove and replace whole cassettes of labware.

When a labware is first moved into the system by the system’s robot, such as 
when it is downstacked, it is assigned an identifier in the database. After that, 
the VWorks software tracks where that labware is at all times. This tracking 
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does not require the labware to have barcode labels, the VWorks software 
tracks what it does with every labware during a protocol and so is able to 
track where each labware goes. Plate groups make use of this tracking system. 

Note: You cannot use a plate group with a Load task, unless a native location 
or location group is associated with it— you must specify a location group. You 
can associate a plate group with the location group so that the labware that 
are loaded are immediately loaded into a plate group as well.

Note: When you load into a plate group you must also load into a location 
group, native location, or choose return to original locations, otherwise the 
software will not know where to put the labware.

Example:
A plate group in a storage device contains the following microplates:

• Plate 26

• Plate 31

• Plate 41

• Plate 107

These microplates are scattered around the storage device, not necessarily in 
adjacent slots of the same cassette. When the Unload task uses this plate 
group, it moves these microplates out of the storage device and into the 
system.

When to use
Plate groups are typically used in compound management systems where 
labware are housed in the storage device almost permanently. 

For each protocol, a different plate group is unloaded, run, and then loaded 
back to a storage device. As long as the identification of the labware is 
tracked, the labware can be stored in any open location.

Group membership

A single labware can be a member of more than one plate group.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 74

Creating a plate group “Creating and managing plate groups” 
on page 76

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88
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Creating and managing location groups

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Procedure

To create a location group:

1 Select Inventory Editor from the Tools menu.

2 Click the Location Groups tab.

3 Click Create new and enter a name for the group.

4 Click OK.

5 Select a group of slots in the Available Slots area.

You can use CTRL+click or SHIFT+click to select more than one slot.

6 Drag the group into the Location Members area.

Note: The slots do not have to be adjacent to each other.

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 93

• VWorks Automation Control User 
Guide

For information about... See...
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7 Click Save Changes.

8 Close the inventory editor.

The location group is listed in the Available locations area of the Load/
Unload Task Parameters toolbar.

Deleting a location group

To delete a location group from the inventory:

1 Open the inventory editor.

2 Select a location group in the Saved Locations group box.

3 Click Delete.

Related information

For information about... See...

Creating a plate group “Creating and managing plate groups” 
on page 76

Opening the inventory editor “Opening the inventory editor” on 
page 71

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88
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Creating and managing plate groups

About this topic

This topic describes how to create a plate group, which is a list of specific 
labware that can be moved to or out of a labware storage device without 
regard for which slots they are stored.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Procedure

To create a plate group:

1 Select Inventory Editor from the Tools menu.

2 Click the Plate Groups tab.

3 Click Create new and enter a name for the group.

4 Click OK.

To add labware to the plate group:

1 Select a group of available labware.

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 93

• VWorks Automation Control User 
Guide

Using storage tasks in a protocol VWorks Automation Control User 
Guide

For information about... See...
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You can use CTRL+click or SHIFT+click to select more than one labware.

2 Drag the group into the Group Members area.

3 Click Save Changes.

4 Close the inventory editor.

The plate group is listed in the Available groups area of the Groups tab in 
the Load/Unload Task Parameters toolbar.

Changing the processing order

You can change the order in which the labware in a plate group will be 
processed.

To change the processing order:

1 In the plate group list, select a labware.

2 Drag it to another position in the list.

Deleting a plate group

To delete a plate group from the inventory:

1 Open the inventory editor.

2 Select the plate group in the Saved Groups group box.
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3 Click Delete.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 74

Opening the inventory editor “Opening the inventory editor” on 
page 71

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 93

• VWorks Automation Control User 
Guide

Using storage tasks in a protocol VWorks Automation Control User 
Guide
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Loading labware into storage devices

About this topic

This topic describes how to add labware into a storage device in the system. 
You do this when filling the device. Adding labware into the system adds the 
labware identifications into the record that the VWorks software tracks in the 
system.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Ways to fill a storage device

There are two ways to fill an empty storage device with labware.

• Robotically

• Manually

Loading labware robotically 

To load labware robotically, the labware are placed in a stacker, downstacked 
and moved to the storage device.

To load labware robotically:

1 Create a protocol.

2 Make sure that the Downstack task is configured to use the stacker.
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3 Create a location group.

Make sure that the location group is listed in the Available locations area 
of the Load Task Parameters toolbar.

4 Drag the group into the Assigned locations area.

5 Click Start and resolve any error messages.

Note: If you are using the simulator to “virtually” load labware, make 
sure that simulation mode is on before you click Start.

6 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of labware you want to load into the storage device.

7 Click OK.

8 To confirm that the labware are in the inventory:

a Click the Load task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab.

Loading labware manually

Labware can be loaded manually two ways:

• Cassettes of labware are physically put in to the storage device and a run 
is simulated to create the matching list of plates in the inventory

• Cassettes of labware are physically put into the storage device, manually 
added to the inventory and then re- inventoried 

Note: To load by reinventory, the storage device must have a barcode 
reader.
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To load labware manually using a simulated run:

1 Physically load the cassettes of labware into the storage device.

2 Follow the procedure to load labware robotically, but turn on the 
simulation mode. To do this, click Simulation is off. The button label changes 
to display Simulation is on.

Make sure that the location group matches the cassettes that you loaded.

3 Click Start to run the simulator.

4 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of labware you want to load into the storage device.

5 Review the inventory editor to make sure that the labware listed in the 
inventory match the labware actually in the device.

6 To turn off the simulation mode, click Simulation is on. The button label 
changes to display Simulation is off.

To load labware manually and then re-inventory:

1 Physically load the cassettes of labware into the storage device.

2 Open the Inventory Editor and click the Inventory Management tab.

3 From the Select view type list, select View by location (shows all available plate 
locations whether they are occupied or not.

4 In the Inventory Management Functions area:

a Enter the name of the labware in the Name field.

b Select the labware type from the Labware list.

c Select Replace inventoried labware with the labware type selected above ONLY if a 
labware type is not already assigned. (This prevents you from accidently 
overwriting an occupied slot with the wrong labware type).

5 Select the slots into which you loaded the labware. Use SHIFT+click or 
CTRL+click to select more than one item.

6 Click Re-inventory selected locations.
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The inventory editor opens.

3 Click the Inventory Management tab and note the device, cassette, and slot 
locations of the microplates that you want to move.

In this example, the microplates will be moved from PlateHub, cassette 1, 
slots 1–4.

4 Click the Location Groups tab and create a location group for these 
microplates.

Note: The labware do not need to be in adjacent slots for them to be in 
a location group.

5 In the Inventory Management tab, note the device, cassette, and slot numbers 
for the destination slots. 

In this example, the microplates will be moved to PlateHub2, cassette 12,  
slots 7- 10.

6 Click the Location Groups tab and create a location group for these slots.

7 Click Save changes and close the inventory editor.

8 Select the Unload task, and in the Task Parameters area drag the location 
group in the first device to the Assigned locations area.

9 Select the Load task, and in the Protocol Task Parameters area drag the 
location group in the second device to the Assigned locations area.
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10 Compile the protocol and check for errors.

11 Click Start to start the run.

12 In the Number of Cycles dialog box, type the number of microplates that you 
are moving and click OK.

13 Open the inventory editor, and click the Inventory Management tab to make 
sure that the microplates moved as expected.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 74

Creating a plate group “Creating and managing plate groups” 
on page 76

Opening the inventory editor “Opening the inventory editor” on 
page 71

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

Incubating labware “Using a plate group to process 
labware” on page 88

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 93

• VWorks Automation Control User 
Guide
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Unloading labware out of inventory

About this topic

This topic describes how to remove plates that are in a storage device from the 
system. Removing labware from the system also removes the labware 
identification from the system records.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Ways to unload labware

There are two ways to remove labware from a plate storage device.

• Robotically

• Manually

Unloading labware robotically

To unload labware from a storage device robotically:

1 Create a protocol.

2 Make sure that the Upstack task is configured to use the appropriate 
stacker.

3 In the inventory editor, identify the labware that you want to move:

a Click the Unload task.

b Click Edit location groups to open the inventory editor.

Load and Unload tasks VWorks Automation Control User 
Guide

For information about... See...
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c Click the Inventory Management tab. Note the device, cassette and slot 
numbers for the labware that you want to remove.

4 If necessary, create a location group in the inventory editor that contains 
the labware you want to remove. 

Save the changes and confirm it by making sure it is listed in the Available 
locations area on the Locations tab of the Load Task Parameters toolbar.

5 Drag the location group into the Assigned locations area.

6 Click Start.

7 In the Number of Cycles dialog box, enter a number that equals the number 
of plates you want to remove from the storage device.

8 Click OK.

9 Confirm that the plates are no longer in the inventory:

a Click the Load task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab.

Unloading a storage device manually

To unload a storage device manually, cassettes of labware are physically 
removed from the storage device and a run is simulated to unload the 
matching list of labware from the inventory. 

To unload plates manually using a simulated run:

1 Physically remove the cassettes of labware from the storage device.

2 Follow step 1 to step 5 in the procedure above for unloading a storage 
device robotically.

3 Click Simulation is off to turn on the simulator.

4 Click Start.

5 In the Number of Cycles dialog box, enter a number that equals the number 
of labware you want to remove from the storage device.

6 Click OK.

7 Confirm that the labware are no longer in the inventory:
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a Click the Load task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab.

To unload labware manually and then reinventory the database:

1 Physically unload the cassettes of labware from the storage device.

2 Open the Inventory Editor and click the Inventory Management tab.

3 From the Select view type list, select View by location (shows all available plate 
locations whether they are occupied or not.

4 Select the slots from which you unloaded the labware. Use SHIFT+click or 
CTRL+click to select more than one slot.

5 In the Inventory Management Functions area, click Delete selected entries from 
inventory. Click Yes to the message asking if you are sure you want to delete 
the selected labware. The labware is deleted from the database.

6 Click Re-inventory selected locations.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 74

Creating a plate group “Creating and managing plate groups” 
on page 76

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Moving labware between storage 
devices” on page 82

Incubating labware “Using a plate group to process 
labware” on page 88

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 93

• VWorks Automation Control User 
Guide
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Using a plate group to process labware

About this topic

This topic shows an example protocol where a plate group is moved out of a 
Plate Hub Carousel, transferred to a liquid- handling device where liquid is 
aspirated, and then loaded back into the same or different locations of the 
Plate Hub Carousel.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, Agilent Technologies Plate 
Hub Carousel.

Before you start

• Place the labware in a Plate Hub Carousel (or other) storage device and 
make sure the labware are stored in the inventory editor.

• Create a plate group containing the labware that you want to process.

To enable the software to track individual plates:
• Under Protocol Options, select the Dynamically assign empty slot to load to storage 

device option. 

Processing a plate group and returning the plates to the original location

To process a plate group:

1 Create a process like the one shown below.

2 Select the Unload task, and in the Task Parameters area, click the Groups tab 
and drag the plate group to the Assigned location area.

3 If you want the labware to be handled in the same numerical order or will 
not be reusing the labware, select Remove plates from group when processed.

Note: The labware can be loaded back into the group during the Load 
task execution.
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4 Select the Load task and then select Use original locations. The Locations and 
Native tabs will become unavailable.

Optional. You can reassign the labware back to the original group or to a 
new plate group. Click the Groups tab and drag the plate group from the 
Available groups area to the Assigned locations area. 

5 Click Start.

6 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of labware that you want to process from the group.

7 Click OK.

8 To confirm that the labware have been returned to their original position 
in the inventory:

a Click the Load task.
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b Click Edit location groups or Edit plate groups.

c Click the Inventory Management tab.

Processing a plate group and returning the labware to a different location

To process a plate group:

1 Create a protocol like the one shown below.

2 Select the Unload task and in the Task Parameters toolbar, click the Groups 
tab and drag the plate group you created at the beginning to the Assigned 
locations area.

3 Select the Load task and in the Task Parameters toolbar choose one of the 
following ways to load the labware into a different location.

• Specify a pre- defined location group to load to. To specify a pre-
defined location group, click the Locations tab and drag the location 
group in the Available locations to the Assigned locations area.
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• Assign specific locations to load to without using a location group. To 
assign specific locations without defining a location group, click the 
Native tab and drag the locations from the Available locations area to the 
Assigned locations area.

4 Click Start.

5 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of labware that you want to process from the group.

6 Click OK.

7 To confirm that the labware have been returned to their assigned positions 
in the inventory:

a Click the Load task.

b Click Edit location groups or Edit plate groups.

c Click the Inventory Management tab.



4   Tracking and managing labware in storage
Using a plate group to process labware

92 VWorks Automation Control Setup Guide

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Creating a plate group “Creating and managing plate groups” 
on page 76

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Using barcode input files • “Creating a plate group with a 
barcode input file” on page 93

• VWorks Automation Control User 
Guide

Starting a run VWorks Automation Control User 
Guide

Load and Unload tasks VWorks Automation Control User 
Guide



93

4   Tracking and managing labware in storage
Creating a plate group with a barcode input file

VWorks Automation Control Setup Guide

Creating a plate group with a barcode input file

About this topic

This topic describes how to use a barcode input file to create a plate group. 
This is the most efficient way to create a plate group if you previously used a 
barcode input file to label a collection of labware that are now stored in a 
storage device.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Procedure

IMPORTANT All labware with barcodes listed in the selected barcode input 
file series must already be in the storage device.

To create a plate group with a barcode input file:

1 Open the inventory editor.

2 Click the Groups tab.

3 Click the Browse button and navigate to the .bar file that you want to use.

4 From the Available Barcode groups list box, select the group that you want to 
use.

In the following example of a barcode input file, the options would be Set1 
and Set2.
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5 Click Import.

The labware labeled with west- side barcodes listed in the series will be 
used to create a group and will appear in the Plates currently in the selected 
group list.

6 In the Inventory Management tab, specify a labware type for each labware.

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Opening the inventory editor “Opening the inventory editor” on 
page 71

Using the labware selection list “Reinventorying the labware inventory” 
on page 100
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Inventory editor views and filters

About this topic

This topic describes how to make the inventory editor easier to work with by 
showing only the items in the inventory editor that are relevant at the 
particular time.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Inventory editor views

There are three ways to view the labware in the inventory editor.

To set the view:

1 Open the inventory editor.

2 Click to select the Inventory Management tab.

3 From the Select view type list, select one of the following options:

Filtering displayed labware

To simplify your view of the database, you can filter the records that are 
displayed.

To filter the labware records:

1 Right- click on a list in any of the tabbed pages of the inventory editor and 
select Show all.

2 Right- click on a particular cell and select from the available filtering 
options.

View Description

View by plate Displays every labware in the inventory. 

This is the most frequently used view.

View by location Displays both labware and slots.

View unassigned 
plates

Displays labware that were orphaned during 
previous runs, or the labware that are in the 
system but not in a storage device.

View Description

Use last filter Returns the display of items to that displayed 
when the last filter was applied

Filter by row The items that have the same value as the selected 
item in the row are displayed
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The items that have the same value as the selected item in the row are 
displayed.

The result is that only those plates in cassette number 2 are listed.

To show all labware records:
Right- click on the database list and select Show all.

Related information

Filter by column The items that have the same value as the selected 
item in the column are displayed

View Description

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Opening the inventory editor “Opening the inventory editor” on 
page 71
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Auditing plate volumes in the inventory editor

About this topic

The VWorks software tracks the pipetting tasks performed on the labware 
during a protocol run, calculating the volume resulting from those tasks, and 
storing the information in the database. When the labware is displayed in the 
software, the volume is represented with color.

This topic describes how to use the inventory editor to audit the volume in a 
labware.

Procedure

To audit the volume of a labware:

1 Open the inventory editor.

2 Click the Inventory Management tab.

3 From the Select view type list, select the view.

4 Select the labware you want to audit.

5 Click Visualize Plate. The Audit Plate dialog box opens.



4   Tracking and managing labware in storage
Auditing plate volumes in the inventory editor

98 VWorks Automation Control Setup Guide

The liquid volume is displayed on the right. You can change the limits of 
this scale in the Scaling area. 

The color legend indicates the following conditions.

Click this button... To...

Zero based plate limits Set the gradient limits from 0 µL 
to the highest volume found in the 
labware.

Auto scale to plate limits Set the scale limits to the lowest 
and highest volume found in the 
labware.

Fixed Scales 1- 7 µL Set the minimum and maximum 
limits to 1 µL and 7 µL, 
respectively.

Manual limits (thresholds) Manually set the lower and upper 
limits. Enter the value (in µL) in 
the Min and Max boxes.
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Double- click on a color in the legend to change it.

Related information

Condition Description

Not surveyed The well is not available for 
measurement.

Empty The well is empty.

Below threshold The well is below the lower limit set 
by the user.

Above threshold The well is above the upper limit set 
by the user.

For information about... See...

Software inventory “About labware inventory management” 
on page 66

Opening the inventory editor “Opening the inventory editor” on 
page 71
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Reinventorying the labware inventory

About this topic

This topic describes how to use the reinventory feature of labware inventory.

This feature can be used to check for mismatches by comparing the identities 
of the labware actually in a storage device to the labware that the inventory 
database says should be in the storage device. 

The reinventory feature can also be used to enter barcode information for 
labware that have been manually placed into the storage device.

Note: Reinventorying requires that the storage device has a barcode reader.

Who should read this

Read this topic if your lab automation system has a storage device that 
includes an optional barcode reader.

About performing an inventory

The accuracy of the inventory database can be checked by performing a new 
inventory of the database. You can perform an inventory of the entire storage 
device or part of it.

The device’s barcode reader checks all selected slots for the presence of a 
barcode and reads those that it finds. The results are checked against the 
inventory database.

IMPORTANT For reinventorying to be successful, each labware must have a 
unique barcode.

Reinventorying logic

If a labware is found in a slot that, according to the inventory database, 
should be empty, a line is added to the inventory editor for that slot and the 
labware barcode is recorded. If that barcode is already associated with another 
slot in the database, the previous association is deleted. In doing this, the 
system assumes that the labware has been manually moved.

If the inventory has a line for a labware in a particular slot, but the inventory 
finds no labware in that slot, the line is removed from the inventory. However, 
the data in the system that is associated with the labware is not deleted. If in 
the future, a labware with an identical barcode is returned to the system, 
when the next inventory is performed the data can be reassociated with it.

Procedure

To reinventory the storage device:

1 Open the inventory editor.

2 Click the Inventory Management tab.

3 From the Select view type list box, select View by location.
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This lists the labware in the inventory database by location.

4 Select the labware that you want to inventory.

You can use SHIFT+click to select a range of listed labware.

5 In the Name box, type the name of the location group.

6 From the Labware box, select the type of labware.

7 Select one of the following options.

8 Click Reinventory selected locations.

A barcode reader reads each labware in the storage device and adds the 
barcode data to the inventory database.

Related information

Option Comments

Replace any inventoried labware 
with the labware selected above

Labware for all selected items are 
replaced with the labware displayed 
in the list box. This overwrites 
labware already assigned.

Replace inventoried labware 
with the labware selected above 
ONLY if a labware is not already 
assigned

Labware for all selected items that do 
not already have a labware entry are 
replaced with the indicated labware.

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 72

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Changing the labware associated 
with labware record in the 
inventory database

“Reinventorying the labware inventory” 
on page 100

Inventory editor filters “Inventory editor views and filters” on 
page 95
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Resolving labware inventory problems

About this topic

This topic describes how to check and test the Windows Open Database 
connection that is used by the VWorks software inventory management system. 

Checking the database settings

The inventory management database uses a Windows Open Database 
Connectivity (ODBC) interface. If you encounter inventory management 
problems, you may need to check the database settings.

To check the database settings:

1 In Windows, navigate to Start > Control Panel > Administrative Tools > Data 
Sources (ODBC).

The ODBC Data Sources Administrator dialog box opens.

2 Click the System DSN tab.

3 Click Configure.

The Connector/ODBC dialog box opens showing the database settings.
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The Data Source Name and Database Name fields must both contain 
velocity11.

Testing the connection

To test the database connection:

1 Follow the procedure in “Checking the database settings” on page 102 to 
open the Connector/ODBC dialog box.

2 Click Test.

A message appears and confirms a successful connection.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 72

Moving labware in and out of a 
storage device

• “Loading labware into storage 
devices” on page 79

• “Unloading labware out of 
inventory” on page 85

• “Moving labware between storage 
devices” on page 82

Changing the labware associated 
with plates in the inventory 
database

“Reinventorying the labware inventory” 
on page 100

Inventory editor filters “Inventory editor views and filters” on 
page 95
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5
Managing user accounts

This chapter contains the following topics:

• “Planning user accounts and privileges” on page 106

• “Managing user accounts” on page 108

• “Setting up email for error notification” on page 110
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Planning user accounts and privileges

The role of user accounts

You must have a user account to log in to VWorks software. Your user account 
is associated with a user role that determines the privileges you have to 
perform particular functions. Users are added and assigned privileges by an 
Administrator.

The effect of privileges

Privileges have the following effects:

• If you do not have the privilege to perform a function associated with a 
particular menu command, the text of the command is gray.

• If you do not have the privilege to perform the functions accessed from a 
particular tabbed page, the tab is not visible to you.

• In some cases, if you do not have the privilege to perform an operation, 
when you attempt the operation you get an error message telling you that 
your privileges are insufficient.

User roles and privileges

User roles enforce the following privileges:

 

User role Has privileges to...

Guest • Log in and log out.

• Access the Knowledge Base through the Help 
menu.

• Use context- sensitive help.

Operator • Perform guest functions (see above).

• Operate devices in real- time using diagnostics 
software.

• Run protocols.

Technician • Perform operator functions (see above).

• Create and save protocols.

• Manage devices through the device manager.

• Perform all of the functions listed in the Tools 
menu (except managing users).

Administrator • Perform technician functions (see above).

• Manage user accounts.

• Run a protocol that contains compiler errors.
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Related information

For information about... See...

managing user accounts “Managing user accounts” on page 108

Setting up email notification “Setting up email for error notification” 
on page 110
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Managing user accounts

About user accounts and passwords

User accounts and passwords use the following conventions:

• User accounts can be disabled but not deleted.

• User names and passwords are case- sensitive.

• Passwords must contain six or more characters.

• If a user enters an incorrect password five times consecutively, the user is 
locked out until an administrator resets the account.

Adding a user account

To add a user account:

1 Select Tools > User Management.

2 In the User Management dialog box, click Create new user and enter a name 
for the user.

3 In the Set Password dialog box, enter the password twice for the new user.

4 Enter values in the User information, and User security areas.

5 Click Update selected user to save changes, and then close the dialog box.

Disabling a user account

You cannot delete a user account, but you can disable it.

To disable an account so that the user cannot log in:

1 Select Tools > User Management.

2 Select the account.

3 Select the Account disabled check box.

4 Click Update selected user to save changes, and then close the dialog box.
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Resetting a user account

If a user mistypes the password five consecutive times, the user is locked out 
of the account until an administrator resets the account.

To reset an account:

1 Select Tools > User Management.

2 Select the account.

3 Click Reset failed login count.

4 Click Update selected user to save changes, and then close the dialog box.

Changing a password

An administrator can reset the password of any account. Technicians can 
change their own passwords at Log in.

To reset a password:

1 Select Tools > User Management.

2 Select the account.

3 Click Set password, enter the new password twice and click OK.

4 Click OK to the Password Update message.

Related information

For information about... See...

User accounts “Planning user accounts and privileges” 
on page 106

Setting up email notification “Setting up email for error notification” 
on page 110
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Setting up email for error notification

About email error notification

Email setup in the VWorks software enables you to do the following tasks:

• Automatically be notified by email or pager when errors occur during a 
protocol run

• Send a bug report to Agilent Technologies

Requirements for email notification

Before you can send an email from VWorks software, the controlling computer 
must:

• Be connected to a network with internet access

• Have network access to an outgoing mail server that supports one of the 
authentication methods available through the VWorks software.

Procedure

To set up the outgoing mail server:

1 Select Tools > Options.

2 In the Email Setup area make sure Enable email notification is selected.

3 Enter the name of your SMTP server name (outgoing email server).

4 If the server requires a user name and password:

a Select the Authentication type from the list.

IMPORTANT The authentication type is critical. Check with your 
network administrator to determine the best authentication network 
for your email server. (NTLM is typically used when Microsoft 
Exchange is the email server.)

b Enter your Authenticated user name and Password for the selected 
authentication type.

5 Next to the Send email from field, enter the email address you want to use 
for auto- generated crash reports.

6 Select Send email when an error occurs, then next to Addresses to send to when an 
error occurs, enter the address to which you want the email delivered. 

Note: Multiple email addresses must be separated with a semicolon.

7 Click OK to save the email setup information and close the dialog box.
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Related information

For information about... See...

Using user accounts “Planning user accounts and privileges” 
on page 106

Managing user accounts “Managing user accounts” on page 108
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6
Troubleshooting problems

This chapter contains the following topics:

• “About troubleshooting guidelines” on page 114

• “Reporting problems” on page 114
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About troubleshooting guidelines

For problems that you encounter after installing the software, you try to locate 
a solution using the guidelines in one of the following documents:

• VWorks Automation Control User Guide

• Applicable user guide for the device

If you are unable to resolve the problem, see “Reporting problems” on 
page 114.

Reporting problems 

Contacting Automation Solutions Technical Support 

If you find a problem with the VWorks software, contact Automation Solutions 
Technical Support at one of the following:

Europe

Phone: +44 (0)1763853638 

email: euroservice.automation@agilent.com

US and rest of world

Phone: 1.800.979.4811 (US only) or +1.408.345.8011

email: service.automation@agilent.com

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready. See the device user guide for the location of the label.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box.

• Relevant software files

To find the VWorks software version number:
In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

mailto:euroservice.automation@agilent.com
mailto:service.automation@agilent.com
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To send compressed protocol and associated files in VZP format:
In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

• Plate map files

• Barcode files

• Error library

• Log files

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
 

Related information

For information about... See...

Troubleshooting problems with the 
VWorks software

VWorks Automation Control User 
Guide

Troubleshooting problems with a 
device controlled by the VWorks 
software

Applicable user guide for the device

mailto:documentation.automation@agilent.com
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7
VWorks ActiveX control

This chapter contains the following topics:

• “About the VWorks ActiveX control” on page 118

• “Methods” on page 120

• “Events” on page 132

• “Enumerated types” on page 136
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About the VWorks ActiveX control 

What is the VWorks ActiveX control

The VWorks ActiveX control is the software component that allows the VWorks 
software to interact with a third- party lab automation system.

How the VWorks ActiveX control is used

In an Agilent Technologies automation system, the VWorks software runs in 
standalone mode, and the ActiveX control is not used. The operator uses the 
VWorks software, which is already configured to control the devices in the 
system. However, some integrations, such as those with LIMS, require that a 
third- party application control the VWorks software. The VWorks ActiveX 
control enables third- party applications to interface with the VWorks software. 
Through the ActiveX control, the third- party application can create an instance 
of the VWorks software, schedule protocol runs, and display various VWorks 
dialog boxes.

Each ActiveX control consists of a collection of the following:

• Methods. Functions that can be called to invoke individual operations

• Properties. Variables that are used in methods (for example, speed = fast)

• Events. Notifications that methods have completed or resulted in errors

To ensure proper integration, you must know the available methods and 
properties for the ActiveX control.

The following diagram illustrates the use of the VWorks ActiveX control in a 
lab automation system environment. Actions you perform are conducted 
through ActiveX methods. System responses are relayed back through ActiveX 
events.

Note: Although the VWorks ActiveX control generates events, the third- party 
application must implement handlers for them.

Computer

Third-party 
software

VWorks

ActiveX

Methods Events
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Integrating the VWorks ActiveX control

When integrating the VWorks ActiveX control in a third-party lab software:

1 Install the VWorks ActiveX control. To install the VWorks ActiveX control:

a Insert the VWorks software CD into the controlling computer CD- ROM 
drive.

b In the CD folder, double- click VWorks Installer.exe.

c Follow the directions in the installation wizard window.

2 Open the Command Prompt window and type VWorks/register to register 
the application program interface.

3 Refer to the description of the Methods and Properties in this section.
 

Related information

For information about... See...

VWorks ActiveX methods “Methods” on page 120

VWorks ActiveX events “Events” on page 132

VWorks ActiveX enumerated types “Enumerated types” on page 136
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Methods

AbortProtocol

Description
Aborts the protocol run that is in progress.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorks4COM.AbortProtocol();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorks4COM.AbortProtocol()

CloseProtocol

Description
Closes the specified protocol file.

Parameters

Returns

Name Type Description

returnCode V11ReturnCode See“Enumerated types” 
on page 136.

Name Type Description

protocol BSTR The protocol file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Note: returnCode is 
RETURN_SUCCESS if the file 
closed successfully.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.CloseProtocol(“myprotocol.pro”);

Visual Basic .NET example
Dim vwRetCode As VWorks4Lib.V11ReturnCode

vwRetCode = oVWorksCOM.CloseProtocol(“myprotocol.pro”)

CompileProtocol

Description
Compiles the protocol and is used with the LogMessage event.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

LONG errCount, wrnCount;

retCode = oVWorks4COM.CompileProtocol (“c:\\myprotocol.pro”, 
&errCount, &wrnCount);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

Dim errCount, wrnCount as Long

retCode = oVWorks4COM.CompileProtocol (“c:\myprotocol.pro”, 
errCount, wrnCount)

EnumerateUsers

Description
Returns the list of users with VWorks accounts.

Parameters
None.

Name Type Description

protocol BSTR The protocol file path.

errorCount *LONG The number of errors found.

warningCount *LONG The number of warnings found.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.
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Returns

Visual Basic .NET example
Dim oEnumerateUsers As Object = Nothing

Dim retCode As VWorks4Lib.V11ReturnCode

Dim sUsers As String = ""

retCode = oVWorksCOM.EnumerateUsers(oEnumerateUsers)

If Not (oEnumerateUsers Is Nothing) Then

Dim i As Integer

For i = 0 To oEnumerateUsers.GetLength(0) - 1

sUsers = sUsers & oEnumerateUsers(i) & " , "

Next

End If

GetSimulationMode

Description
Gets the simulation mode state.

Parameters
None.

Returns

Name Type Description

user *VARIANT The user name.

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

mode VARIANT_BOOL The value that indicates the 
simulation state:

• True = The simulation 
mode is on.

• False = The simulation 
mode is off.
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Visual C++ example
VARIANT_BOOL bSimMode;

bSimMode= oVWorksCOM.GetSimulationMode();

Visual Basic .NET example
Dim bSimMode as Boolean

bSimMode= oVWorksCOM.GetSimulationMode()

GetTipStates

Description
Gets the state of the tipboxes in a protocol for automated tip tracking.

Parameters

Returns

Visual Basic .NET example
Dim TipStateXML As String = ""

Dim retCode As VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.GetTipStates(“c:\myprotocol.pro”, 
TipStateXML)

LoadProtocol

Description
Loads the protocol for a run.

Parameters

Returns

Name Type Description

protocol BSTR The protocol file path.

Name Type Description

TipStateXML BSTR The current status of the 
tipboxes.

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

protocol BSTR The protocol file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.CompileProtocol(“c:\\myprotocol.pro”);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM.CompileProtocol (“c:\myprotocol.pro”)

LoadRunsetFile

Description
Loads the runset file.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.LoadRunsetFile (“c:\\myrunset.rst”);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM.LoadRunsetFile (“c:\myrunset.rst”)

Login

Description
Logs into VWorks software using the provided user name and password.

Parameters

Name Type Description

runset BSTR The runset file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

userName BSTR The user name.

password BSTR The password.
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Returns

Visual C++ example
VWorks4Lib.V11LoginResult retCode;

loginResult= oVWorksCOM.Login(“user1”,“mypassword!”);

Visual Basic .NET example
Dim loginResult as VWorks4Lib.V11LoginResult

loginResult= oVWorksCOM.Login(“user1”,“mypassword!”)

Logout

Description
Logs out the current user session.

Parameters
None.

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.Logout();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.Logout()

PauseProtocol

Description
Pauses the protocol run that is in progress. The tasks that are in progress will 
be finished. No new tasks will be started.

Parameters
None.

Returns

Name Type Description

loginResult V11LoginResult See “Enumerated types” on 
page 136.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.PauseProtocol();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.PauseProtocol()

ReinitializeDevices

Description
Reinitializes devices.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ReinitializeDevices ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ReinitializeDevices ()

ResumeProtocol

Description
Resumes the protocol run.

Parameters
None.

Returns

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.ResumeProtocol ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.ResumeProtocol ()

RunProtocol

Description
Starts the protocol run.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.RunProtocol (“c:\\myprotocol.pro”,2);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM.RunProtocol (“c:\myprotocol.pro”,2)

SetSimulationMode

Description
Sets the simulation mode.

Parameters

Name Type Description

protocol BSTR The protocol file path.

runCount LONG The number of times to run 
the protocol.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

mode VARIANT_BOOL The value that sets the 
simulation state:

• True = Turns on the 
simulation mode.

• False = Turns off the 
simulation mode.
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Returns

Visual C++ example
oVWorksCOM.SetSimulationMode(VARIANT_TRUE);

oVWorksCOM.SetSimulationMode(VARIANT_FALSE);

Visual Basic .NET example
oVWorksCOM.SetSimulationMode(True)

oVWorksCOM.SetSimulationMode(False)

ShowDiagsDialog

Description
Displays the device diagnostics dialog box.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowDiagsDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowDiagsDialog ()

ShowLoginDialog

Description
Displays the User Authentication (or login) dialog box.

Parameters
None

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Note: returnCode is always 
RETURN_SUCCESS.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.



129

7   VWorks ActiveX control
Methods

VWorks Automation Control Setup Guide

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowLoginDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowLoginDialog ()

ShowManageUserDialog

Description
Displays the User Management dialog box.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowManageUserDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowManageUserDialog ()

ShowOptionsDialog

Description
Displays the Options dialog box.

Parameters
None

Returns

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowOptionsDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowOptionsDialog ()

ShowPlateGroupEditorDialog

Description
Displays the Plate Group Editor dialog box.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowPlateGroupEditorDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowPlateGroupEditorDialog ()

ShowTipStateEditor

Description
Displays the Tip State Editor dialog box.

Parameters

Returns

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

Name Type Description

Protocol BSTR The protocol file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowTipStateEditor 
(“c:\\myprotocol.pro”);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowTipStateEditor 
(“c:\myprotocol.pro”)

ShowVWorks

Description
Displays or hides the VWorks software window.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowVWorks (VARIANT_TRUE);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowVWorks (True)

Related information

Name Type Description

showOrHide VARIANT_BOOL The value that displays or 
hides the window:

• TRUE = Display the 
window.

• FALSE = Hide the window.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 136.

For information about... See...

VWorks ActiveX control “About the VWorks ActiveX control” on 
page 118

VWorks ActiveX events “Events” on page 132

VWorks ActiveX enumerated types “Enumerated types” on page 136
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Events

LogMessage

Description
The LogMessage event occurs every time a message is posted to the log.

Parameters

Returns
None.
                                                        

Name Type Description

session LONG The session ID.

logClass LONG The type of log event: Error, 
Warning, or Event.

timeStamp BSTR The time at which the error 
occurred.

device BSTR The device name. An empty 
string is permitted.

location BSTR The location. An empty string 
is permitted.

process BSTR The process plate name. An 
empty string is permitted.

task BSTR The task name. An empty 
string is permitted.

fileName BSTR The protocol file or device file 
name. An empty string is 
permitted.

message BSTR The the error message text.
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MessageBoxAction

Description
The MessageBoxAction occurs when a user response is required.

Parameters

Returns

ProtocolComplete

Description
The ProtocolComplete event occurs after startup, cleanup, and main protocols 
are finished.

Paramters

Name Type Description

caption BSTR The title of the message.

message BSTR The message body.

session LONG The session ID.

type LONG The type of message:

0 = MB_OK

1 = MB_OKCANCEL

2 = MB_ABORTRETRYIGNORE

3 = MB YESNOCANCEL

4 = MB_YESNO

5 = MB_RETRYCANCEL

Name Type Description

actionToTake LONG* The value that indicates the 
action to take:

1 = OK 

2 = CANCEL

3 = ABORT

4 = RETRY

5 = IGNORE

6 = YES

7 = NO

Name Type Description

session LONG The session ID.

protocol BSTR The protocol file path.

protocol_type BSTR The type of protocol: Startup, 
Main, or Cleanup.
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Returns
None.

ProtocolAborted

Description
The ProtocolAborted event occurs when the operator or automation client 
aborts the protocol run.

Parameters

Returns
None.

RecoverableError

Description
The RecoverableError event occurs whenever an error is displayed and expects 
the operator to abort, retry, or ignore the error.

Parameters

Returns

Name Type Description

session LONG The session ID.

protocol BSTR The protocol file path.

protocol_type BSTR The type of protocol: Startup, 
Main, or Cleanup.

Name Type Description

session LONG The session ID.

device BSTR The device name. An empty 
string is permitted.

location BSTR The location. An empty string is 
permitted.

description BSTR The description of the error.

Name Type Description

actionToTake *LONG The value that indicates the 
action to take:

• 0 = Abort

• 1 = Retry

• 2 = Ignore
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UnrecoverableError

Description
The UnrecoverableError event occurs when an error is displayed and does not 
expect the operator to respond with a decision.

Parameters

Returns
None.

UserMessage

Description
The UserMessage event occurs when a User Message task occurs.

Parameters

Returns

vworksHandlesError *VARIANT_BOOL Value values are:

• TRUE = Allows the VWorks 
software to handle the error. 
the VWorks software will not 
display the error message.

• FALSE = Prevents the VWorks 
software from handling the 
error.

Name Type Description

Name Type Description

session LONG The session ID.

description BSTR The description of the error.

Name Type Description

session LONG User message tasks can 
prompt user for data entry.

caption BSTR

message BSTR

wantsData VARIANT_BOOL

Name Type Description

userData *BSTR Allows user to enter data if 
wantsData = True.
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Related information

Enumerated types

V11ReturnCode

Description
Indicates the method call status.

Constants

V11LoginResult

Description
Indicates the login status.

Constants

For information about... See...

VWorks ActiveX control “About the VWorks ActiveX control” on 
page 118

VWorks ActiveX methods “Methods” on page 120

VWorks ActiveX enumerated types “Enumerated types” on page 136

Name Value Description

RETURN_SUCCESS 0 The method was called 
successfully.

RETURN_BAD_ARGS 1 The method contains bad 
arguments.

RETURN_FAIL 2 The method call failed.

Name Value Description

LOGIN_SUCCESS 0 The login was successful.

LOGIN_FAIL 1 The login failed.

LOGIN_DISABLED 2 The login was disabled.

LOGIN_EXPIRED 3 The login period passed.

LOGIN_TOO_MANY_FAILED
_ATTEMPTS

4 Too many login attempts were 
made and failed.
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Related information

LOGIN_NOT_ENOUGH_AUT
HORIZATION

5 Higher access priveleges are 
required to perform the 
requested action.

Name Value Description

For information about... See...

VWorks ActiveX control “About the VWorks ActiveX control” on 
page 118

VWorks ActiveX methods “Methods” on page 120

VWorks ActiveX events “Events” on page 132
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Setting up a MySQL database 

This chapter contains the following topics:

• “Workflow for setting up a MySQL database” on page 140

• “Installing and configuring a MySQL database” on page 141

• “Setting up a MySQL ODBC in Windows” on page 145
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Workflow for setting up a MySQL database

About this topic

The VWorks labware inventory management feature requires an SQL database. 
An SQL database may already be set up if the computer was configured by 
Agilent Technologies to control a device that uses a database, for example, a 
Plate Hub Carousel. 

If you have a VWorks simulation license and your computer was not configured 
by Agilent Technologies, you must install and configure the SQL database 
before you can use the inventory management feature. 

Workflow

The following procedures are for the Microsoft Windows XP operating system.

Step For this task... See...

1 Download the installation files, 
install and configure a MySQL 
database.

“Installing and configuring a 
MySQL database” on page 141

2 Set up a MySQL ODBC in 
Windows

“Setting up a MySQL ODBC in 
Windows” on page 145

3 Connect to the VWorks 
inventory management 
database

“Connecting to the inventory 
management database” on page 69



141

A
Installing and configuring a MySQL database

VWorks Automation Control Setup Guide

Installing and configuring a MySQL database

About this topic

Read this topic if you have a VWorks simulation license and want to use the 
VWorks labware inventory management feature. 

This topic describes how to install and configure the MySQL database, which is 
required for the inventory management feature. 

Note: The database may be configured already if the computer was provided by 
Agilent Technologies and your system contains a device that requires a 
database, such as a Plate Hub. 

Obtaining the installation software

Download the installation files for the generally available (GA) releases of the 
following software for the Windows platform:

• MySQL Connector/ODBC 3.51 (Windows msi installer) 
http://dev.mysql.com/downloads/connector/odbc/3.51.html

• MySQL Server 5.x (Windows Essentials) 
http://dev.mysql.com/downloads/mysql/5.0.html

Installing the software

The following procedures are for the Microsoft Windows XP operating system.

To install MySQL Connector/ODBC:

1 Double- click the installation file (*.msi). The MySQL Connector/ODBC 
Setup Wizard appears.

2 Click Next to start the wizard. Select the Typical setup, click Next, and 
follow the instructions that appear on the screen.

                                                        

http://dev.mysql.com/downloads/connector/odbc/3.51.html
http://dev.mysql.com/downloads/mysql/5.0.html
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To install MySQL Server:

1 Double- click the Windows Essentials MySQL installation file (*.msi). The 
MySQL Server Setup Wizard appears.

2 Click Next to start the wizard. Select the Typical setup, click Next, and 
follow the instructions that appear on the screen.

3 On the Wizard Completed page, select the Configure the MySQL Server now 
check box, and then click Finish. The MySQL Server Configuration wizard 
appears.

4 To start the configuration wizard, click Next. 

5 Choose the Standard Configuration, and then click Next. 

6 When the Windows options page appears, select the following check boxes, 
and then click Next:

a Install as Windows Service

b Launch the MySQL Server automatically

c Include Bin Directory in Windows PATH
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7 On the Security options page, do the following, and then press Next:

a Select Modify Security Settings

b Enter the password as velocity11

c Select Enable root access from remote machines

d Select Create An Anonymous Account

8 On the Ready to execute page, click Execute to start the configuration file 
creation.

9 When the configuration file has been successfully created and the security 
settings have been applied, click Finish.
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Related information

For information about... See...

Setting up a MySQL database “Workflow for setting up a MySQL 
database” on page 140

How to set up a MySQL ODBC 
connection in Windows

“Setting up a MySQL ODBC in 
Windows” on page 145

VWorks labware inventory 
management feature

“About labware inventory management” 
on page 66

How to connect to the VWorks 
inventory management database

“Connecting to the inventory 
management database” on page 69
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Setting up a MySQL ODBC in Windows

About this topic

Read this topic if you have a VWorks simulation license and want to use the 
VWorks labware inventory management feature. If your computer was not 
configured by Agilent Technologies, you must install and configure the SQL 
database before you can use the inventory management feature.

This topic describes how to set up the MySQL ODBC in Microsoft Windows.

Before you begin

Make sure you have the following file:

\Program Files\Agilent Technologies\VWorks\Schema\velocity11_mysql5.sql 

Procedure

To set up a MySQL ODBC connection:

1 Copy the velocity11_mysql5.sql file to the following folder on the computer:

\Program Files\MySQL\MySQL Server 5.0\bin\ 

2 From the Windows desktop, open a command window as follows:

a Choose Start > Run. 

b In the Run dialog box, type cmd, and click OK. 

3 In the command window:

a Type the following and press ENTER:

cd c:\program files\mysql\mysql server 5.0\bin

This command changes the directory to the MySQL Server 5.0 program 
directory.

b To copy the provided velocity11 database file into the MySQL Server 
program, type the following and press ENTER:

mysql < velocity11_mysql5.sql

c Close the command window.

4 To open the ODBC Data Source Administrator:

a Choose Start > Control Panel, and then double- click Administrative Tools.

b Double- click Data Sources (ODBC). The ODBC Data Source Administrator 
window appears.
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IMPORTANT Remove any previously defined MySQL ODBC Driver 
Sources before continuing.

5 Click the System DSN tab and press Add to create a new data source.

6 In the Create New Data Source window, select MySQL ODBC 3.51 Driver, and 
then Finish.

7 In the Connector/ODBC 3.51.21- Add Data Source Name window, click the 
Login tab, and enter the following to define your data source:

• Data Source Name: velocity11

• Description: v11 database (optional)

• Server: localhost

• User: root

• Password: velocity11

• Database: velocity11
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8 Click the Advanced tab, and on the Flags 1 page, select the following:

• Return Matching Rows

• Enable Auto Reconnect

9 To verify that the data source file is properly configured, press Test. A 
message appears telling you that the connection was successful. Click OK.

10 On the System DSN tab, verify that velocity11 appears in the System Data 
Source box, and then click OK.
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Related information

For information about... See...

The steps to follow for setting up 
a MySQL database

“Workflow for setting up a MySQL 
database” on page 140

How to install and configure 
MySQL

“Installing and configuring a MySQL 
database” on page 141

VWorks labware inventory 
management feature

“About labware inventory management” 
on page 66

How to connect to the VWorks 
inventory management database

“Connecting to the inventory 
management database” on page 69
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Glossary

clamps (BenchCel)  The components inside of the 
stacker head that close and open the stacker 
grippers during the loading, unloading, 
downstacking, and upstacking processes.

controlling computer  The lab automation system 
computer that controls the devices in the system.

cycle  See seal cycle.

deadlock  An error that occurs when the number of 
locations available in the system is less than the 
number of microplates in the system. Because the 
microplates cannot move to the expected 
locations, the protocol pauses.

device  An item on your lab automation system that 
can have an entry in the device file. A device can 
be a robot, an instrument, or a location on the lab 
automation system that can hold a piece of 
labware.

device file  A file that contains the configuration 
information for a device. The device file has the 
.dev file name extension and is stored in the 
folder that you specify when saving the file.

downstack  The process in which a microplate is 
moved out of the stack.

error handler  The set of conditions that define a 
specific recovery response to an error.

home position  The position where all robot axes are 
at the 0 position (the robot head is approximately 
at the center of the x- axis and at 0 of the z- axis, 
and the robot arms are perpendicular to the x-
axis). 

homing  The process in which the robot is sent to the 
factory- defined home position for each axis of 
motion.

hot plate (PlateLoc)  A heated metal plate inside the 
sealing chamber that descends and presses the 
seal onto the plate.

insert  A pad placed under the plate to support the 
bottom of the wells for uniform sealing. 

location group  A list of labware that can be moved 
into or out of particular slots in a storage device.

plate group  A list of specific labware that can be 
moved into or out of a storage device without 
regard for the slot locations.

plate instance  A single labware in a labware group 
that is represented by the process plate icon. 

plate stage  The removable metal platform on which 
you load a plate.

plate-stage support  The structure on which you load a 
plate stage. The plate- stage support extends when 
the door opens.

profile  The Microsoft Windows registry entry that 
contains the communication settings required for 
communication between a device and the VWorks 
software.

process  A sequence of tasks that are performed on a 
particular labware or a group of labware.

protocol  A schedule of tasks to be performed by a 
standalone device, or devices in the lab 
automation system.

regrip station  A location that enables the robot to 
change its grip orientation (landscape or portrait), 
or adjust its grip at the specified gripping height. 
Grip height adjustment might be necessary after a 
robot picks up a labware higher than the specified 
gripping height because of physical restrictions at 
a teachpoint.

robot grippers  The components that the robot uses to 
hold labware.

run  A process in which one or more microplates are 
processed. In a standalone device, the run 
consists of one cycle. In a lab automation system, 
a run can consist of multiple cycles that are 
automated.

safe zone  The boundary within which the robot is 
allowed to move without colliding with external 
devices.

seal cycle  The process in which a single plate is 
sealed on the PlateLoc Sealer.

seal entry slot  The narrow entry on the back of the 
PlateLoc Sealer where the seal is inserted into the 
device.

seal-loading card  A rectangular card that is used to 
facilitate the seal loading process on the PlateLoc 
Sealer.

seal-roll support  The triangular structures at the top 
of the PlateLoc Sealer where a roll of seal is 
mounted.
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sealing chamber  The area inside of the PlateLoc 
Sealer where the seal is applied to a plate.

shelves (BenchCel)  The components inside of the 
stacker head that provide leveling surfaces for the 
microplates, thus ensuring accurate robot 
gripping, during the downstacking process.

stacker grippers  The padding at the bottom of the 
stacker racks that hold microplates when a 
microplate is loaded, downstacked, or upstacked.

subprocess  A sequence of tasks performed as a 
subroutine within a protocol. Typically the 
subprocess is performed by a single device type, 
such as the Bravo device.

task  An operation performed on one or more 
labware.

task parameters  The parameters associated with each 
task in a protocol. For example, in a labeling task, 
the parameters include the label value.

teachpoint  A set of coordinates that define where the 
robot can pick up or place labware and the 
location of a known object.

teachpoint file  The XML file that contains the settings 
for one or more device teachpoints. 

touch screen  The interface on the front of the 
PlateLoc Sealer where sealing parameters are set, 
the seal cycle can be started or stopped, and the 
seal cycle can be monitored.

upstack  The process in which a microplate is moved 
back into the stack.

waypoint  A set of coordinates that define a location 
the robot passes through on its way to a 
teachpoint.

workspace  The boundary within which the robot can 
move without limitations.
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Index
A
acceleration property, 60
ActiveX

described, 118
enumerated types, 136
events, 132
methods, 120

administrator privilege, 106

B
barcode

input file, 93
inventory manager, 66
tracking, 66

C
can be mounted property, 31
can be sealed? property, 30
can have lid? property, 30
can mount property, 31
cassette, defined, 66
check orientation property, 50
column-wise teachpoint to well property, 33
column-wise well to well property, 34
computer

requirements, 3
context-sensitive help, ix
Cytomat, 79

manually loading labware, 80
manually unloading labware, 86
moving between
robotically loading labware, 79
robotically unloading labware, 85
with inventory manager, 66

D
database

backup, 69
connection, 69
inventory management, 66
reinventorying, 100
reinventorying, connection checking, 102
setting up, 69
SQL, 66, 139
synchronizing, 68

disposable tip capacity property, 34
disposable tip length property, 34

E
errors

reporting, 114, 115

G
general properties for labware, defining, 26
guest privilege, 106

H
hardware

errors, 114

I
image, inserting labware, 40
Incubate at Storage Device task, 68
inventory editor, 67

close, 71
opening, 71

inventory group, defined, 72
inventory management, database, 66
inventory manager, 67

database connection, checking, 102
filters, 95
overview, 66
views, 95

inventory, synchronizing, 68
inventory. see also reinventory

J
job roles for readers of this guide, vi

K
knowledge base, viii

L
labware

adding, 24
classes page, 35
defining classes, 35
defining general properties, 26
defining pipette/well properties, 32
defining plate properties, 28
defining stacker properties, 48
inserting an image, 40
moving between storage devices

Labware Editor
classes page, 18
entries page, 16
opening, 21

length of filter tip/pin tool property, 31
licenses, software, 2
lid properties, 31
lidded stacking thickness property, 30
lidded thickness property, 30
liquid library



152 VWorks Automation Control Setup Guide

Index

adding an entry, 59
calibrating the pipettor, 57
classes defined, 56
database defined, 57
editor defined, 56
opening the editor, 58

Liquid Library Editor
about, 56
opening, 58

Load task, 68, 71
location group, 67

creating, 74
defined, 72
deleting, 75

lower plate at Microplate Labeler property, 31

M
maximum robot handling speed property, 31
migrating files from VWorks3, VWorks4, or BenchWorks, 

7
MySQL database, 139

N
notch locations property, 50

O
online help, viii
operator privilege, 106
orientation sensor offset property, 49
orientation sensor threshold (max) property, 49
orientation sensor threshold (min) property, 49

P
passwords, 108
PDF guide, viii
pipette/well, defining labware properties, 32
plate group, 67

changing processing order, 77
creating, 76
creating with barcode input file, 93
defined, 72
deleting, 77
processing plates using, 88, 90

plate group editor, 66
Plate Hub Carousel, 79

with inventory manager, 66
manually loading labware, 80
moving labware between
robotically loading labware, 79
robotically unloading labware, 85

plate inventory. see reinventory
plate properties, defining, 28
plates. see  labware
post-aspirate delay property, 60

post-dispense delay property, 61
presentation offset property, 49
privileges, user, 106
property, 30

acceleration, 60
can be mounted, 31
can be sealed?, 30
can have lid?, 30
can mount, 31
check orientation, 50
column-wise teachpoint to well, 33
column-wise well to well, 34
disposable tip capacity, 34
disposable tip length, 34
length of filter tip/pin tool, 31
lidded stacking thickness, 30
lidded thickness, 30
lower plate at Microplate Labeler, 31
maximum robot handling speed, 31
notch locations, 50
orientation sensor offset, 49
orientation sensor threshold, 49
post-aspirate delay, 60
post-dispense delay, 61
presentation offset, 49
row-wise teachpoint to well, 33
row-wise well to well, 34
sealed stacking thickness, 30
sealed thickness, 30
sensor intensity, 49
shim/nesting thickness, 30
stacker gripper offset, 49
stacking thickness, 29
thickness, 29
use vacuum clamps, 50
velocity, 60
well depth, 33
well diameter, 33
well geometry, 33
well volume, 33
well-bottom shape, 33
z-axis acceleration into wells, 60, 61
z-axis acceleration out of wells, 60, 61
z-axis speed into wells, 60
z-axis velocity into wells, 61
z-axis velocity out of wells, 60, 61

R
reinventorying storage device, 100
row-wise teachpoint to well property, 33
row-wise well to well property, 34

S
sealed stacking thickness property, 30
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sealed thickness property, 30
sensor intensity property, 49
shim/nesting thickness, 30
slot, defined, 66
software

errors, 114
license upgrades, 2
reporting errors, 114
version number, 114

SQL database, 66, 139
stacker gripper offset property, 49
stacker, defining properties for labware, 48
stacking thickness property, 29
storage device

manually loading labware, 80
manually unloading labware, 86
reinventorying, 100
robotically loading labware, 79
robotically unloading labware, 85

StoreX, 79
manually loading labware, 80
manually unloading labware, 86
moving labware between
robotically loading labware, 79
robotically unloading labware, 85
with inventory manager, 66

synchronizing inventory database, 68

T
technician privilege, 106
thickness property, 29

U
Unload task, 68, 71
use vacuum clamp property, 50
user accounts

changing password, 109
disabling, 108
editing, 108
passwords, 108
privileges, 106
resetting lock out, 109

V
velocity property, 60

W
well depth property, 33
well diameter property, 33
well geometry property, 33
well volume property, 33
well-bottom shape property, 33

Z
z-axis

acceleration into wells property, 60, 61
acceleration out of wells property, 60, 61
speed into wells property, 60
velocity into wells property, 61
velocity out of wells property, 60, 61
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